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Student Guide

In this student guide, you will learn about the LabVIEW 
Learning Path, the course description, and the items you 
need to get started in the LabVIEW Core 1 course. 

Topics
+ NI Certification

+ Course Description

+ What You Need to Get Started

+ Installing the Course Software

+ Course Goals
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A.NI Certification
The LabVIEW Core 1 course is part of a series of courses designed to build your proficiency with 
LabVIEW and help you prepare for the NI Certified LabVIEW Associate Developer exam. The 
following illustration shows the courses that are part of the LabVIEW training series. Refer to 
ni.com/training for more information about NI Certification.

B. Course Description
The LabVIEW Core 1 course teaches you programming concepts, techniques, features, VIs, and 
functions you can use to create test and measurement, data acquisition, instrument control, 
datalogging, measurement analysis, and report generation applications. This course assumes 
that you are familiar with Windows and that you have experience writing algorithms in the form 
of flowcharts or block diagrams. 

The Participant Guide is divided into lessons. Each lesson contains the following:

• An introduction with the lesson objective and a list of topics and exercises.

• Slide images with additional descriptions of topics, activities, demonstrations, and 
multimedia segments.

• A set of exercises to reinforce topics. Some lessons include optional and challenge 
exercises.

• A lesson review that tests and reinforces important concepts and skills taught in the lesson.

Note For Participant Guide updates and corrections, refer to ni.com/info and 
enter the Info Code core1.

Several exercises use a plug-in multifunction data acquisition (DAQ) device connected to a DAQ 
Signal Accessory or BNC-2120 containing a temperature sensor, function generator, and LEDs.

If you do not have this hardware, you still can complete the exercises. Alternate instructions 
are provided for completing the exercises without hardware. You also can substitute other 
hardware for those previously mentioned. For example, you can use another National 
Instruments DAQ device connected to a signal source, such as a function generator.

Certified LabVIEW
Associate Developer

Certified LabVIEW
Developer

Certified LabVIEW
Architect

LabVIEW
Connectivity

LabVIEW
Performance

Advanced
Architectures
in LabVIEW

Managing
Software

Engineering
in LabVIEW

Object-Oriented
Design &

Programming
in LabVIEW

LabVIEW Learning Path

LabVIEW
Core 1

LabVIEW
Getting Started

LabVIEW
Core 3LabVIEW

Core 2
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C.What You Need to Get Started
Before you use this course manual, make sure you have all of the following items:

 Computer running Windows 7/Vista/XP

 Multifunction DAQ device configured as Dev1 using Measurement & Automation Explorer 
(MAX)

 DAQ Signal Accessory or BNC-2120, wires, and cable

 LabVIEW Professional Development System 2014 or later

 DAQmx 14 or later

 A GPIB cable

 NI-488.2 14 or later

 NI-VISA 14.0.1 or later

 NI Instrument Simulator and power supply

 NI Instrument Simulator Wizard installed from the NI Instrument Simulator software CD

 LabVIEW Core 1 course CD, from which you install the following folders:

D. Installing the Course Software
Complete the following steps to install the course software.

1. Insert the course CD in your computer. The LabVIEW Core 1 Course Setup dialog box 
appears.

2. Click Install the course materials.

3. Follow the onscreen instructions to complete installation and setup.

Exercise files are located in the <Exercises>\LabVIEW Core 1\ folder.

Note Folder names in angle brackets, such as <Exercises>, refer to folders on 
the root directory of your computer.

E. Course Goals
This course prepares you to do the following:

• Understand front panels, block diagrams, icons, and connector panes

• Use the programming structures and data types that exist in LabVIEW

• Use various editing and debugging techniques

• Create and save VIs so you can use them as subVIs

• Display and log data

• Create applications that use plug-in DAQ devices

• Create applications that use serial port and GPIB instruments

Directory Table Head

Exercises Contains VIs used in the course

Solutions Contains completed course exercises
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This course does not describe the following:

• Every built-in VI, function, or object; refer to the LabVIEW Help for more information about 
LabVIEW features not described in this course

• Analog-to-digital (A/D) theory

• Operation of the GPIB bus

• Developing an instrument driver

• Developing a complete application for any student in the class; refer to the NI Example 
Finder, available by selecting Help»Find Examples, for example VIs you can use and 
incorporate into VIs you create





1 Navigating 
LabVIEW

In this lesson you will learn to recognize the main 
components of the LabVIEW environment and be able to 
create a new project and VI.

Topics
+ What is LabVIEW?

+ Project Explorer

+ Parts of a VI

+ Front Panel

+ Block Diagram

+ Searching for Controls, VIs, and Functions

Exercises
Exercise 1-1 Concept: Exploring a VI

Exercise 1-2 Concept: Locating Controls, Functions, and VIs
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A.What is LabVIEW?
Objective: Recognize benefits of LabVIEW. 

LabVIEW is a graphical programming environment you can used to develop sophisticated 
measurement, test, and control systems. 

Benefits of LabVIEW
• A platform-based approach for measurement and control

• Interfaces with wide variety of hardware

• Scales across different targets and operating systems

• Provides built-in analysis libraries

LabVIEW Language Characteristics

LabVIEW Core 1 Topics LabVIEW Core 2 and Later Topics

Graphical

Uses icons and wires instead of with text.

Multi-threaded

Enables your code to have automatic 
parallelism.

Dataflow-oriented

Data-driven, or data-dependent. The flow of 
data between nodes in the G code 
determines the execution order.

Object-oriented

Allows a variety of similar, yet different 
items, to be represented as a class of objects 
in software.

Compiled

Compiles G code directly to machine code.

Multi-target

Targets multicore processors and other 
parallel hardware such as field-programmable 
gate arrays (FPGAs).
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Activity 1-1: Confidence Activity—Building a VI
Goal
Build an application to calculate the product of two numbers.

B. Project Explorer
Objective: Recognize the main components of the Project Explorer.

LabVIEW Files
Listed below are some of the characteristics of a LabVIEW project.

• Manages project files

• Deploys programs to remote embedded targets such as NI CompactRIO

• Creates stand-alone executables and installers for distribution

• Makes it possible to distribute code to developers and create shared libraries

• Can integrate LabVIEW programs with source code control software such as Perforce

Multi-platform

Is portable between LabVIEW on different 
operating systems.

Memory-managed

Provides you with options for improving 
performance.

Synchronous

Event-driven

Allows the user's direct interaction with the 
program without the need for polling.

Project Explorer Projects in LabVIEW consist of VIs, files necessary for those VIs to run 
properly, and supplemental files such as documentation or related 
links. Use the Project Explorer window to manage projects in 
LabVIEW. A LabVIEW project is denoted by a project file (.lvproj)

Common LabVIEW File Extensions

LabVIEW Project — .lvproj

Virtual Instrument (VI) — .vi

Custom Control — .ctl

LabVIEW Core 1 Topics LabVIEW Core 2 and Later Topics
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Demonstration: Using the Project Explorer and Starting a VI
The Project Explorer window includes the following items by default:

• Project root—Contains all other items in the Project Explorer window. The label on the 
project root includes the filename for the project. 

• My Computer—Represents the local computer as a target in the project. 

• Dependencies—Includes VIs and items that VIs under a target require.

• Build Specifications—Includes build configurations for source distributions and other types 
of builds available in LabVIEW toolkits and modules. If you have the LabVIEW Professional 
Development System or Application Builder installed, you can use Build Specifications to 
configure stand-alone applications, shared libraries, installers, and zip files. 

When you add another target to the project, LabVIEW creates an additional item in the Project 
Explorer window to represent the target. Each target also includes Dependencies and Build 
Specifications sections. You can add files under each target. 

Tip The Source Control toolbar is only available if you have source control 
configured in LabVIEW.

Adding Folders to a Project
Add folders to a project to create an organizational structure for project items.

1 Standard Toolbar
2 Project Toolbar
3 Build Toolbar
4 Source Control Toolbar

5 Project Root
6 Target 
7 Dependencies
8 Build Specifications

Auto-Populated Folders Virtual Folders

Adds a directory on disk to the project Organizes project items and does not 
represent files on disk

LabVIEW continuously monitors and updates 
the folder according to changes made in the 
project and on disk

Can convert a virtual folder to an 
auto-populated folder. 

1 2 43

8 57 6
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C. Parts of a VI
Objective: Recognize and understand the difference between the front panel and block 

diagram.

Demonstration: Components of a VI
LabVIEW VIs contain three main components—the front panel window, the block diagram, and 
the icon/connector pane.

1 Auto-populating folder 2 Virtual folder

Front Panel Block Diagram Icon/Connector Pane

Is the user interface. Contains the graphical 
source code.

Represents the VI and makes 
it possible to use the VI as a 
subVI.

Has controls (inputs) and 
indicators (outputs).

Contains terminals for front 
panel controls and 
indicators.

Maps the inputs and outputs 
to the VI.

1

2
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D. Front Panel 
Objective: Recognize the components and functionality of the Front Panel window and 

select appropriate controls and indicators

Front Panel Window Toolbar
Use the front panel window toolbar buttons to run and edit the VI.

Controls and Indicators

Front Panel User interface for the VI. Contains controls and indicators, which are 
the interactive input and output terminals of the VI, respectively.

Controls Indicators

Interactive input Interactive output

Knobs, push buttons, dials, and other inputs Graphs, LEDs, and other displays

Simulate instrument input devices and 
supply data to the block diagram

Simulate instrument output devices and 
display data the block diagram acquires or 
generates
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String, Boolean, and Numeric Data Types
The following table shows controls and indicators of the string, Boolean, and numeric data 
types.

Activity 1-2: Select Front Panel Objects
Goal
For each scenario, determine the appropriate data type and whether the front panel object 
should be a control or indicator.

The string data type is a 
sequence of ASCII 
characters.

Use string controls to 
receive text from the user 
such as a password or user 
name. Use string 
indicators to display text 
to the user.

The Boolean data type 
represents data that only 
has two possible states, 
such as TRUE and FALSE 
or ON and OFF. 

Use Boolean controls and 
indicators to enter and 
display Boolean values. 

The numeric data type can 
represent numbers of 
various types, such as 
integer or real. 

The two common numeric 
objects are the numeric 
control and the numeric 
indicator.

Scenario Data Type Control/Indicator

Display the temperature of a 
room

Numeric Indicator

An Emergency stop button 
to stop a process

Username and password to 
login to your bank account

An LED to display error 
status
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Front Panel Object Styles
LabVIEW has different control palettes with objects for building user interfaces. These palettes 
include the Modern, Silver, Classic, and Systems palettes.
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E. Block Diagram 
Objective: Recognize features of the Block Diagram and be able to select functions.

Block Diagram Toolbar
When you run a VI, buttons appear on the block diagram toolbar that you can use to debug 
the VI.

Block Diagram Block diagram objects include terminals, subVIs, functions, constants, 
structures, and wires, which transfer data among other block diagram 
objects.
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Demonstration: Components of a Block Diagram

Express VIs
Express VIs are a type of subVI that you configure with dialog boxes. Icons for Express VIs 
appear on the block diagram as icons surrounded by a blue field.

Component Description

Terminals Terminals are the entry and exit ports that exchange information 
between the front panel and block diagram. You can view terminals as 
icon conserve space.

Nodes Nodes are objects on the block diagram that have inputs and/or outputs 
and perform operations when a VI runs. Nodes are analogous to 
statements, operators, functions, and subroutines in text-based 
programming languages. Nodes can be functions, subVIs, or structures.

Function Nodes 
(Functions)

Functions are fundamental operating elements of LabVIEW and do not 
have front panels or block diagrams. Function icons have pale yellow 
backgrounds.

SubVIs SubVIs are VIs that run on the block diagram of another VI. They have 
front panels and block diagrams. Any VI has the potential to be used as 
a subVI. When you double-click a subVI, the front panel and block 
diagram open.

Icon Icons are the graphical representations of VIs.

Use the icon from the upper-right corner of the front panel as the icon 
that appears when you place the subVI on a block diagram. 

Connector Pane The connector pane is the map of inputs and outputs of a VI

The connector pane terminals correspond to the controls and indicators 
on the front panel of the VI. You cannot access the connector pane from 
the block diagram window.
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Nodes Appearance
You can display VIs and Express VIs as either icons or expandable nodes. Use icons if you want 
to conserve space on the block diagram. By default, subVIs appear as icons on the block 
diagram, and Express VIs appear as expandable nodes. 

To display a subVI or Express VI as an expandable node, right-click the subVI or Express VI and 
remove the checkmark next to the View As Icon shortcut menu item.

Wires
Wires transfer data between block diagram objects. A broken wire appears as a dashed black 
line with a red X in the middle. You cannot run a VI that contains a broken wire.

Broken wires occur for a variety of reasons, such as when you try to wire two objects with 
incompatible data types.

1 Icon 2 Expandable Node 3 Expanded Node

Common Wire Types

Wire Type Scalar 1D Array 2D Array Color

Numeric Orange (floating-point), 
Blue (integer)

Boolean Green

String Pink
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Demonstration: Context Help and LabVIEW Help
Use the Context Help window and the LabVIEW Help to help you create and edit VIs.

Context Help Window
The Context Help window displays basic information about LabVIEW objects when you move 
the cursor over each object. 

To toggle display of the Context Help window select Help»Show Context Help, press the 
<Ctrl-H> keys, or click the Show Context Help Window button on the toolbar.

LabVIEW Help
You can access the LabVIEW Help by clicking the More Help button in the Context Help 
window, selecting Help»LabVIEW Help, or clicking the blue Detailed Help link in the Context 
Help window. You also can right-click an object and select Help from the shortcut menu.
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Examples
Use the NI Example Finder to browse or search examples installed on your computer or on the 
NI Developer Zone at ni.com/zone. These examples demonstrate how to use LabVIEW to 
perform a wide variety of test, measurement, control, and design tasks. Select Help»Find 
Examples to launch the NI Example Finder.
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F. Searching for Controls, VIs, and Functions
Objective: Find the controls, indicators, and functions you need.

Demonstration: Searching For Controls, VIs, and Functions
Controls Palette
The Controls palette contains the controls and indicators you use to create the front panel. 
Select View»Controls Palette to display it. 

Navigate the subpalettes or use the Search button to search the Controls palette. 

Figure 1-3.  Controls Palette
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Functions Palette
The Functions palette contains the VIs, functions and constants you use to create the block 
diagram. Select View»Functions Palette to display it. 

Navigate the subpalettes or use the Search button to search the Functions palette.

Figure 1-4.  Functions Palette

Quick Drop
The Quick Drop dialog box lets you quickly find controls, functions, VIs, and other items by 
name. Press the <Ctrl-Space> keys to display the Quick Drop dialog box.

Global Search
Use the Search bar in the top right of the front panel and block diagram windows to search 
palettes, LabVIEW Help, and ni.com.
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Additional Resources

Learn More About LabVIEW Help Topic

Project Explorer Creating a Project

Managing a Project in LabVIEW

Front Panel Building the Front Panel
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Activity 1-3: Lesson Review
Answer the following questions and then discuss your answers with the class.

1. What are the three parts of a VI?

a. Front panel

b. Block diagram

c. Project

d. Icon/Connector pane
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Activity 1-3: Lesson Review - Answers
1. What are the three parts of a VI?

a. Front panel

b. Block diagram

c. Project

d. Icon/Connector pane





2 Creating Your 
First Application

In this lesson you will learn to use Express VIs to produce 
a project and create a simple VI that acquires and analyzes 
data and then displays the results.

Topics
+ Dataflow

+ LabVIEW Data Types

+ Tools for Programming, Cleaning and Organizing Your VI

+ Building a Basic VI

Exercises
Exercise 2-1 Selecting a Tool

Exercise 2-2 Simple AAV VI
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A.Dataflow
Objective: Recognize characteristics of dataflow on the block diagram.

Key Points of Dataflow
LabVIEW follows a dataflow model for running VIs.

Activity 2-1: Exploring Dataflow
Goal: Understand how dataflow determines the execution order in a VI.

Description: Work through this exercise on your own first, and then as a class, we will discuss 
how data flow determines execution order. You can find answers to these questions following 
this section.

Note Nodes are objects on the block diagram that have inputs and/or outputs and 
perform operations when a VI runs. 

Using Figure 2-1, answer questions 1 through 5.

1. Which node executes first? Is there any dependency between the File Dialog function and 
the Simulate Signal Express VI?

2. Which node executes last?

3. Because a wire connects the File Dialog function to the TDMS File Viewer VI, can the TDMS 
File Viewer VI execute before the TDMS Close function? 

4. How many nodes must execute before the TDMS Write function can execute?

Dataflow Dataflow is the movement of data through the nodes of a block diagram.

1 Node executed only when all the input data are available.
2 Node supplies data to the output terminals only when it is finished executing.

1

2
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5. Should a well-designed block diagram flow in a particular direction?

Figure 2-1.  Dataflow: Example A

6. In Figure 2-2, which Express VI executes last?

Figure 2-2.  Dataflow: Example B
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7. In Figure 2-3 an error wire connects the Express VIs. Which Express VI executes last?

Figure 2-3.  Dataflow: Example C

8. In Figure 2-4, which Tone Measurements Express VI executes last?

Figure 2-4.  Dataflow: Example D
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Activity 2-1: Exploring Dataflow - Answers
1. Which node executes first? Is there any dependency between the File Dialog function and 

the Simulate Signal Express VI?

Either the File Dialog function or the Simulate Signal Express VI can execute first. There is 
no data dependency between the two nodes so either of them can execute first or they can 
execute simultaneously.

2. Which node executes last?

The last node to execute is the Simple Error Handler VI. 

Note Terminals are not considered nodes.

3. Because a wire connects the File Dialog function to the TDMS File Viewer VI, can the TDMS 
File Viewer VI execute before the TDMS Close function?

No. The TDMS File Viewer VI cannot execute before the TDMS Close function because the 
yellow error wire connecting the TDMS Close function and the TDMS File Viewer VI forces 
data dependency. Remember, the data to all inputs of a node must be available before a 
node can execute. Therefore, the TDMS File Viewer VI must receive data from both the 
green Boolean wire and the yellow error wire before the VI can execute.

4. How many nodes must execute before the TDMS Write function can execute?

Three nodes must execute before the TDMS Write function can execute: File Dialog, TDMS 
Open, and Simulate Signal. The TDMS Write function also depends on the Simulated Signal 
string constant, but that input is instantaneous.

5. Should a well-designed block diagram flow in a particular direction?

Yes. A well-designed block diagram typically flows from left to right. This makes it easier 
to see the flow of data on the block diagram. However, do not assume left-to-right or 
top-to-bottom execution when no data dependency exists.

6. In Figure 2-2, which Express VI executes last?

Either the Statistics Express VI or the Write to Measurement File Express VI executes last 
or they execute in parallel. The DAQ Assistant Express VI cannot execute last because both 
the Statistics Express VI and the Write to Measurement File Express VI are dependent on 
the data signal from the output of the DAQ Assistant Express VI. 

Note In LabVIEW, the flow of data, rather than the sequential order of commands, 
determines the execution order of block diagram elements. Therefore, it is possible 
to have simultaneous operations.

7. In Figure 2-3 an error wire connects the Express VIs. Which Express VI executes last?

The Write to Measurement File Express VI executes last. It has a data dependency on both 
the DAQ Assistant Express VI and the Statistics Express VI.

8. In Figure 2-4, which Tone Measurements Express VI executes last?

Either one of the Tone Measurement Express VIs can execute last. Even though the Tone 
Measurements 2 Express VI has an extra dependency on the Filter Express VI, the Filter 
Express VI might execute before the Tone Measurements 1 Express VI allowing the Tone 
Measurements 2 Express VI to execute before the Tone Measurements 1 Express VI. 
Although it seems as if the Tone Measurements 1 Express VI would execute first, without 
an explicit data dependency there is no way to know definitely it would execute first.
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B. LabVIEW Data Types
Objective: Recognize the different data types and how they relate to front panel objects.

Terminals and LabVIEW Data Types
Block diagram terminals visually communicate information about the data type represented. 
Terminal colors, text, arrow direction, and border thickness all provide visual information about 
the terminal. 

Demonstration: Accessing Object Properties
Shortcut Menus
• Use shortcut menu items to change the appearance or behavior of objects.

• To access the shortcut menu, right-click the object.

Property Dialog Boxes
• To access properties, right-click the object and select Properties.

• Select multiple objects to simultaneously configure shared properties.
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Boolean Data
Use Boolean controls and indicators to enter and display Boolean (TRUE/FALSE) values. 
LabVIEW stores Boolean data as 8-bit values. If the 8-bit value is zero, the Boolean value is 
FALSE. Any nonzero value represents TRUE. 

Multimedia: Mechanical Actions of Boolean Controls
Boolean controls have six types of mechanical action that allow you to customize Boolean 
objects to create front panel windows that more closely resemble the behavior of physical 
instruments.

Complete the multimedia module, Mechanical Actions of Boolean Controls, available in the 
<Exercises>\LabVIEW Core 1\Multimedia\ folder.

Multimedia: Numeric Data Representations
LabVIEW represents numeric data types as floating-point numbers, fixed-point numbers, 
integers, unsigned integers, and complex numbers. The difference among the numeric data 
types is the number of bits they use to store data and the data values they represent.

Complete the multimedia module, Numeric Data Representations, available in the 
<Exercises>\LabVIEW Core 1\Multimedia\ folder. 
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Strings
A string is a sequence of displayable or non-displayable ASCII characters. Strings provide a 
platform-independent format for information and data. Some of the more common applications 
of strings include the following:

• Creating simple text messages.

• Controlling instruments with text commands 

• Storing numeric data to disk. To store numeric data in an ASCII file, first convert data to 
strings.

• Instructing or prompting with dialog boxes.

• Right-click a string control or indicator on the front panel to select from the display type.

Display Type Description Message

Normal Display Displays printable 
characters using the font 
of the control. 
Non-displayable characters 
generally appear as boxes.

There are four display types. \ 
is a backslash.

‘\’ Codes Display Displays backslash codes 
for all non-displayable 
characters.

There\sare\sfour\sdisplay\stypes
.\n\\\sis\sa\
sbackslash.

Password Display Displays an asterisk (*) for 
each character including 
spaces.

********************************
*************

Hex Display Displays the ASCII value of 
each character in hex 
instead of the character 
itself.

5468 6572 6520 6172 6520 666F 
7572 2064 6973 706C 6179 2074 
7970 6573 2E0A 5C20 6973 2061 
2062 6163 6B73 6C61 7368 2E
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Demonstration: Enums
Enums give users a list of items from which to select. Enums are useful because they make 
strings equivalent to numbers, which are easy to manipulate on the block diagram. Each item 
represents a pair of values: a string value and a 16-bit integer.

Other Data Types

How might a Path data type differ from a String data type? 

Although it is easy to convert a Path to a String, it is best to use a Path data type when working 
with a location of a file or directory because LabVIEW can handle the folder specifiers for the 
specific operating system, such as using a backslash on Windows OS.

Type Terminal Description

Dynamic Stores the information generated or acquired by an 
Express VI

Path Stores the location of a file or directory using the 
standard syntax for the platform you are using

Waveform Carries the data, start time, and dt of a waveform
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C. Tools for Programming, Cleaning and 
Organizing Your VI
Objective: Recognize tools for making clean, readable front panels and block diagrams, and 

for documenting VIs.

Demonstration: Programming Tools
You can create, modify and debug VIs using the tools provided by LabVIEW. LabVIEW chooses 
which tool to select based on the current location of the mouse. If you need more control, use 
the Tools palette to select a specific tool.

Tip You can manually choose the tool you need by selecting it on the Tools palette. 
Select View»Tools Palette or press <Shift> and right-click to display the palette.

Tool Icon Description

Operating Use the Operating tool to change the values 
of a control.

Positioning Use the Positioning tool to select or resize 
objects.

Labeling Use the Labeling tool to enter text in a 
control, to edit text, and to create free labels.

Wiring Use the Wiring tool to wire objects together 
on the block diagram.

Automatic Tool 
Selection

When this is selected, LabVIEW automatically 
chooses a tool based on the location of your 
cursor. You can turn off automatic tool 
selection by deselecting the item, or by 
selecting another item in the palette.

Object Shortcut 
Menu 

Use the Object Shortcut Menu tool to access 
an object shortcut menu with the left mouse 
button.

Scrolling Use the Scrolling tool to scroll through 
windows without using scrollbars.

Breakpoint Use the Breakpoint tool to set breakpoints on 
VIs, functions, nodes, wires, and structures 
to pause execution at that location.
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Demonstration: Wiring Tips
• Press <Ctrl-B> to delete all broken wires.

• To clean up one wire, right-click the wire and select Clean Up Wire.

• To reroute multiple wires and objects, select a section of your block diagram then click the 
Clean Up Diagram button. 

• To clone an object, select the object with the Positioning tool and hold the <CTRL> key 
down while dragging the object to a new location.

Probe Use the Probe tool to create probes on wires 
on the block diagram. Use the Probe tool to 
check intermediate values in a VI that 
produces questionable or unexpected results.

Color Copy Use the Color Copy tool to copy colors for 
pasting with the Coloring tool.

Coloring Use the Coloring tool and the color picker to 
color an object. The Coloring tool displays the 
current foreground and background color 
settings. Select the Coloring tool and 
right-click an object or workspace to display 
the color picker.

Tool Icon Description
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Exercise 2-1 Selecting a Tool

Goal
Become familiar with automatic tool selection and the Tools palette in LabVIEW.

Description
During this exercise, you complete tasks in a partially built front panel and block diagram. These 
tasks give you experience using the automatic tool selection.

1. Open Using Temperature.lvproj in the <Exercises>\LabVIEW Core 1\Using 
Temperature directory.

2. Open Using Temperature.vi from the Project Explorer window.

3. Select View»Tools Palette from the menu to display the Tools window. 

Tip Press <Shift> and right-click the front panel to open the Tools palette 
temporarily.

Figure 2-5 shows an example of the front panel as it appears after your modifications. In steps 4 
through 9 you increase the size of the waveform chart, rename the numeric control, change the 
value of the numeric control, and move the knob.

Figure 2-5.  Using Temperature VI Front Panel
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4. Expand the waveform chart horizontally using the Positioning tool.

 Move the cursor to the right edge of the Chart waveform chart until you see the resizing 
nodes appear around the chart.

 Move the cursor to the middle right resizing node until the cursor changes to a double 
arrow, as shown in Figure 2-6.

Figure 2-6.  Resize Waveform Chart

 Drag the repositioning node until the waveform chart is the size you want.

5. Rename the waveform chart using the Labeling tool.

 Double-click the word Chart. LabVIEW highlights the word and automatically selects 
the Labeling tool in the Tools window.

 Enter the text Temperature Chart.

 Complete the entry by clicking outside the control label or clicking the Enter Text button 
on the toolbar.

 Notice that LabVIEW automatically returns to the Positioning tool in the Tools window. 
The Positioning tool is the default tool. If LabVIEW does not switch back to the 
Positioning tool, click the Automatic Tool Selection button in the Tools window to 
enable automatic tool selection.

6. Rename the Numeric control to Number of Measurements using the Labeling tool.

 Double click the word Numeric.

 Enter the text Number of Measurements.

 Complete the entry by clicking outside the control or clicking the Enter Text button on 
the toolbar.

7. Change the value of the Number of Measurements control to 100 using the Labeling tool.

 Move the cursor to the interior of the Number of Measurements control.

 When the cursor changes to the Labeling tool icon, click the mouse button.

 Enter the text 100.
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 Complete the entry by clicking outside the control, clicking the Enter Text button on 
the toolbar, or pressing the <Enter> key on the numeric keypad,

 Change the value of the Delay Multiplier knob using the Operating tool.

 Move the cursor to the knob.

 When the cursor changes to the Operating tool icon, press the mouse button and drag 
to the value you want.

 Set the value to 1.

8. Change the color of the Delay Multiplier knob using the Coloring tool. 

 Click the background square in the Coloring button and select a color from the color 
picker.

 When the cursor changes to a paintbrush, click the Delay Multiplier knob.

 Click the Automatic Tool Selection button again to turn on automatic tool selection.

9. Try changing the value of objects, resizing objects, and renaming objects until you are 
comfortable with using these tools.

10. Open the block diagram of the VI.

Figure 2-7 shows an example of the block diagram as it appears after your modifications. 
Steps 11 through 12 instruct you on how to update the block diagram to move the Number 
of Measurements terminal and wire the terminal to the count terminal of the For Loop.

Figure 2-7.  Using Temperature VI Block Diagram

11. Move the Number of Measurements terminal using the Positioning tool.

 Move the cursor to the Number of Measurements terminal.

 Move the cursor over the terminal until the cursor changes to an arrow.

 Click and drag the terminal to the new location as shown in Figure 2-7.
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12. Wire the Number of Measurements terminal to the count terminal of the For Loop using the 
Wiring tool.

 Move the cursor to the Number of Measurements terminal.

 Move the cursor to the right of the terminal, stopping when the cursor changes to a 
wiring spool.

 Click to start the wire.

 Move the cursor to the count (N) terminal of the For Loop. 

 Click the count terminal to end the wire.

13. Try moving other objects, deleting wires and rewiring them, and wiring objects and wires 
together until you are comfortable with using these tools.

14. Automatically clean up the entire block diagram.

 Click the Clean Up Diagram button on the LabVIEW toolbar.

 Press <Ctrl-Z> to undo the clean-up.

Tip You can also select specific objects to clean up, such as wires or individual 
nodes. <Shift>-click to select multiple objects and then click the Clean Up Diagram 
button. LabVIEW cleans up only the objects that you select and not the entire block 
diagram. Configure how LabVIEW cleans up objects by selecting Tools»Options from 
the menu, clicking the Block Diagram category, and changing the options in the 
Block Diagram Cleanup section.

15. Change the Boolean text of the Stop button. 

Note Boolean controls and indicators have Boolean text labels in addition to their 
control labels. Boolean text labels change depending on the value of the control or 
indicator. The label for the control or indicator does not change depending on the 
value of the control or indicator. 
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 Right-click the Stop Button terminal and select Properties from the shortcut menu. Set 
the properties as shown in Figure 2-8.

Figure 2-8.  Changing the Boolean Text for the Stop Control

 Click the OK button to close the dialog box.

 Right-click the Stop Button terminal and select Find Control from the shortcut menu. 
Notice the control label is Stop Button and the button text is End.

Tip You can also double-click the Stop Button terminal to find the button control 
on the front panel.

16. Click the Run button to run the VI.

The time required to execute this VI is equivalent to Number of Measurements times Delay 
Multiplier. When the VI is finished executing, the Temperature Chart displays the data. 

17. Close the VI and click the Don’t Save - All button. You do not need to save the VI.

End of Exercise 2-1

1 Control label—This text identifies the terminal of the Boolean control for programming 
purposes. This text does not appear on the front panel unless you select Visible.

2 Boolean text—This text appears only on the front panel, and by default, appears in the 
center of the Boolean control.

1

2
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Demonstration: Making Code Readable
Block diagram comments can describe the function or operation of algorithms and explain the 
purpose of data that passes through wires. 

Label Guidelines 
• Use free labels to document algorithms and add reference information.

• Label structures to specify the main functionality.

• Label long wires to identify their use/contents. 

• Label constants to specify the nature of the constant.

• To avoid clutter, document the Context Help window of subVIs or functions instead of 
labels. 

Default Values
Setting a default value on a control or indicator can aid in future development and 
troubleshooting by giving the programmer an idea of the expected data for that object. 
Configure default values for controls and indicators by right-clicking on the object and selecting 
Data Operations»Make Current Value Default from the short-cut menu.

Owned Labels Free Labels

Explain data contents of wires and objects. Describe algorithms.

Move with object. Have fixed location.

Have transparent backgrounds. Have pale yellow backgrounds.

Created by selecting Visible Items»Label 
from the shortcut menu.

Created by double-clicking in any open 
space.
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D.Building a Basic VI
Objective: Recognize Express VIs and be able to apply them appropriately.

Building a Basic VI
Express VIs are designed specifically for completing common, frequently used operations. 

On the Functions palette, the Express VIs are grouped together in the Express category. Express 
VIs use the dynamic data type to pass data between Express VIs.

VI Icon Description

Acquire DAQ Assistant Acquires data through a data acquisition 
device.You must use this Express VI 
frequently throughout this course. 

Instrument I/O 
Assistant

Acquires instrument control data, usually 
from a GPIB or serial interface.

Simulate Signal Generates simulated data such as a sine 
wave.

Read from 
Measurement 
File

Reads a file that was created using the Write 
To Measurement File Express VI. It 
specifically reads LVM or TDM file formats. 
This Express VI does not read ASCII files.
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Analyze Amplitude and 
Level 
Measurements

Performs voltage measurements on a signal. 
These include DC, rms, maximum peak, 
minimum peak, peak to peak, cycle average, 
and cycle rms measurements.

Statistics Calculates statistical data from a waveform. 
This includes mean, sum, standard deviation, 
and extreme values.

Tone 
Measurements

Searches for a single tone with the highest 
frequency or highest amplitude. It also finds 
the frequency and amplitude of a single tone.

Spectral 
Measurements

Performs spectral measurement on a 
waveform, such as magnitude and power 
spectral density.

Filter Processes a signal through filters and 
windows. Filters used include the following: 
Highpass, Lowpass, Bandpass, Bandstop, 
and Smoothing. Windows used include 
Butterworth, Chebyshev, Inverse Chebyshev, 
Elliptical, and Bessel.

Visualize Write to 
Measurement 
File

Writes a file in LVM or TDMS file format.

Build Text Creates text, usually for displaying on the 
front panel window or exporting to a file or 
instrument.

Front panel 
indicators

— Examples include Waveform Chart, 
Waveform Graph, and XY Graph.

VI Icon Description
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Activity 2-2: Program Architecture for Simple AAV VI

1. Acquire: Circle the Express VI that is best suited to acquire a sine wave from a data 
acquisition device. 

2. Analyze: Circle the Express VI that is best suited to determining the average value of the 
acquired data. 

3. Visualize: Circle the Express VIs and/or indicators that are best suited to displaying the data 
on a graph and logging the data to file. 

Refer to the next page for answers to this quiz.

DAQ Assistant The DAQ Assistant acquires data through a 
data acquisition device.

Instrument I/O Assistant The Instrument I/O Assistant acquires 
instrument control data, usually from a GPIB 
or serial interface.

Simulate Signal The Simulate Signal Express VI generates 
simulated data, such as a sine wave.

Tone Measurements The Tone Measurements Express VI 
finds the frequency and amplitude of 
a single tone.

Statistics The Statistics Express VI calculates 
statistical data from a waveform.

Amplitude and Level Measurements The Amplitude and Level 
Measurements Express VI performs 
voltage measurements on a signal.

Filter The Filter Express VI processes a 
signal through filters and windows.

DAQ Assistant The DAQ Assistant acquires data through a 
data acquisition device.

Write to Measurement File The Write to Measurement File Express VI 
writes a file in LVM or TDM file format.

Build Text The Build Text Express VI creates text, usually 
for displaying on the front panel window or 
exporting to a file or instrument.

Waveform Graph The waveform graph displays one or more plots 
of evenly sampled measurements.
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Activity 2-2: Program Architecture for Simple AAV VI - 
Answers

1. Acquire: Use the DAQ Assistant to acquire the sine wave from the data acquisition device.

2. Analyze: Use the Statistics Express VI to determine the average value of the sine wave. 
Because this signal is cyclical, you could also use the Cycle Average option in the Amplitude 
and Level Measurements Express VI to determine the average value of the sine wave.

3. Visualize: Use the Write to Measurement File Express VI to log the data and use the 
Waveform Graph to display the data on the front panel window.
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Exercise 2-2 Simple AAV VI

Goal
Create a simple VI that acquires, analyzes, and displays data.

Scenario
You need to acquire a sine wave for 0.1 seconds, determine and display the average value, log 
the data, and display the sine wave on a graph.

Design
The input for this problem is an analog channel of sine wave data. The outputs include a graph 
of the sine data, a file that logs the data, and an indicator that displays the average data value.

Flowchart
The flowchart in Figure 2-9 illustrates the data flow for this design.

Figure 2-9.  Simple AAV VI Flowchart

Implementation
1. Prepare your hardware to generate a sine wave. If you are not using hardware, skip to 

step 2.

 Find the BNC-2120 and visually confirm that it is connected to the DAQ device in your 
computer. 

 Using a BNC cable, connect the Analog In Channel 1 to the Sine Function Generator, 
as shown in Figure 2-10. 

 Set the Frequency Selection switch and the Frequency Adjust knob to their lowest 
levels.

Acquire Data

Determine
Average Value

ACQUIRE ANALYZE VISUALIZE

Display Average
Value

Display Data

Log Data
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Figure 2-10.  Connections for the BNC-2120

2. Open LabVIEW.

3. Create a blank project. Save the project as Simple AAV.lvproj in the 
<Exercises>\LabVIEW Core 1\Simple AAV directory. 

4. Add a new VI to the project from the Project Explorer window and save the VI as Simple 
AAV.vi in the <Exercises>\LabVIEW Core 1\Simple AAV directory. 
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In steps 5 through 6 you will build a front panel similar to the one in Figure 2-11.

Figure 2-11.  Simple AAV VI Front Panel Window

5. Add a waveform graph to the front panel window to display the acquired data. 

 Press <Ctrl-Space> to open the Quick Drop dialog box.

 Type Waveform in the text box and double-click Waveform Graph (Silver) in the search 
results list. 

 Place the graph in the front panel window. 

6. Add a numeric indicator to the front panel window to display the average value.

 Press <Ctrl-Space> to open the Quick Drop dialog box.

 Type Numeric Indicator in the text box and double-click Numeric Indicator (Silver) 
in the search results list.

 Place the indicator in the front panel window. 

 Change the numeric indicator label to Average Value.
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In the steps 7 through 14 you build a block diagram similar to the one in Figure 2-12.

Figure 2-12.  Simple AAV VI Block Diagram

7. Open the block diagram of the VI by selecting Window»Show Block Diagram.

Note The terminals corresponding to the front panel window objects appear on the 
block diagram. 

8. Acquire a sine wave for 0.1 seconds by following the instructions in Table 2-1. If you have 
hardware installed, follow the instructions in the Hardware Installed column to acquire the 
data using the DAQ Assistant. If you do not have hardware installed, follow the instructions 
in the No Hardware Installed column to simulate the acquisition using the Simulate Signal 
Express VI.

Table 2-1.  Instructions for Acquiring or Simulating Data

Hardware Installed No Hardware Installed

1. Press <Ctrl-Space> to open the Quick 
Drop dialog box.

1. Press <Ctrl-Space> to open the Quick 
Drop dialog box.

2. Type DAQ Assist in the text box and 
double-click DAQ Assistant in the 
search results list.

2. Type Simulate Signal in the text 
box and double-click Simulate Signal in 
the search results list.

3. Place the DAQ Assistant on the block 
diagram. 

3. Place the Simulate Signal Express VI on 
the block diagram.

4. Wait for the DAQ Assistant dialog box 
to open. 

4. Wait for the Simulate Signal dialog box 
to open. 

5. Select Acquire Signals»Analog Input»
Voltage for the measurement type. 

5. Select Sine for the signal type.

6. Select ai1 (analog input channel 1) for 
the physical channel.

6. Set the signal frequency to 100.

7. Click the Finish button. 7. In the Timing section, set the Samples 
per second (Hz) to 1000.
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Tip Reading 100 samples at a rate of 1,000 Hz retrieves 0.1 seconds worth of 
data.

9. Use the Statistic Express VI to determine the average value of the data acquired.

 Press <Ctrl-Space> to open the Quick Drop dialog box.

 Type statistics in the text box and double-click Statistics [NI_ExpressFull.lvlib] in 
the search results list.

 Place the Statistics Express VI on the block diagram to the right of the DAQ Assistant 
(or Simulate Signal Express VI). 

 Wait for the Statistics Express VI dialog box to open. 

 Place a checkmark in the Arithmetic mean checkbox. 

 Click the OK button.

10. Log the generated sine data to a LabVIEW Measurement File.

 Press <Ctrl-Space> to open the Quick Drop dialog box.

 Type write to measurement in the text box and double-click Write to Measurement 
File in the search results list.

 Place the Write to Measurement File Express VI on the block diagram below the 
Statistics Express VI. 

 Wait for the Write to Measurement File Express VI dialog box to open. 

 Leave all configuration settings in the Write to Measurement File dialog box as default. 

 Click the OK button.

Note Future exercises do not detail the directions for finding specific functions or 
controls in the palettes. Use Quick Drop, the palette search feature, or the global 
search to locate functions and controls.

11. Wire the data from the DAQ Assistant (or Simulate Signal Express VI) to the Statistics 
Express VI. 

 Place the mouse cursor over the data output of the DAQ Assistant (or the Sine output 
of the Simulate Signal Express VI) at the location where the cursor changes to the 
Wiring tool. 

 Click the mouse button to start the wire. 

8. In the Timing Settings section, select 
N Samples as the Acquisition Mode.

8. In the Timing section, deselect 
Automatic for the Number of samples.

9. In the Timing Settings section enter 
100 in Samples To Read.

9. In the Timing section, set the Number 
of samples to 100.

10. Enter 1000 in Rate (Hz). 10. In the Timing section, select the 
Simulate acquisition timing option.

11. Click the OK button. 11. Click the OK button.

Table 2-1.  Instructions for Acquiring or Simulating Data (Continued)

Hardware Installed No Hardware Installed
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 Place the mouse cursor over the Signals input of the Statistics Express VI and click the 
mouse button to end the wire. 

12. Wire the data to the graph indicator.

 Place the mouse cursor over the data output wire of the DAQ Assistant (or the Sine 
output of the Simulate Signal Express VI) at the location where the cursor changes to 
the Wiring tool. 

 Click the mouse button to start the wire. 

 Place the mouse cursor over the Waveform Graph indicator and click the mouse button 
to end the wire. 

13. Wire the Arithmetic Mean output of the Statistics Express VI to the Average Value numeric 
indicator.

 Place the mouse cursor over the Arithmetic Mean output of the Statistics Express VI 
at the location where the cursor changes to the Wiring tool. 

 Click the mouse button to start the wire. 

 Place the mouse cursor over the Average Value numeric indicator and click the mouse 
button to end the wire. 

14. Wire the data output to the Signals input of the Write Measurement File Express VI.

 Place the mouse cursor over the data output wire of the DAQ Assistant (or the Sine 
output of the Simulate Signal Express VI) at the location where the cursor changes to 
the Wiring tool. 

 Click the mouse button to start the wire. 

 Place the mouse cursor over the Signals input of the Write Measurement File Express 
VI and click the mouse button to end the wire. 

Note Future exercises do not detail the directions for wiring between objects.

15. Save the VI.

Test
1. Switch to the front panel window of the VI.

2. Set the graph properties to be able to view the sine wave.

 Right-click the waveform graph and select X Scale»Autoscale X to remove the 
checkmark and disable autoscaling.

 Use the labeling tool to change the last number on the Time scale of the waveform 
graph to .1.

3. Save the VI. 

4. Click the Run button on the front panel toolbar to run the VI. The graph indicator should 
display a sine wave and the Average Value indicator should display a number around zero. 
If the VI does not run as expected, review the implementation steps.

5. Close the VI. 

End of Exercise 2-2
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Additional Resources

Learn More About LabVIEW Help Topic

Terminal symbols for controls and 
indicators

Numeric Data Types Table

Using Express VIs Express VIs

Working with Express VIs

Acquiring or Simulating a Signal

Visualizing data Types of Graphs and Charts
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Activity 2-3: Lesson Review
Refer to the figure below to answer the following quiz questions.

1. Which function executes first: Add or Subtract?

a. Add

b. Subtract

c. Unknown

2. Which function executes first: Sine or Divide?

a. Sine

b. Divide

c. Unknown

3. Which function executes first: Random Number, Divide or Add?

a. Random Number

b. Divide

c. Add

d. Unknown

4. Which function executes last: Random Number, Subtract or Add?

a. Random Number

b. Subtract

c. Add

d. Unknown

5. If an input to a function is marked with a red dot (known as coercion dot), what does the 
dot indicate?

a. Data was transferred into a structure.

b. That input has not been wired

c. The wire is broken

d. The value passed into a node was converted to a different representation.

6. Which mechanical action causes a Boolean control in the FALSE state to change to TRUE 
when you click it and stay TRUE until LabVIEW has read the value?

a. Switch Until Released

b. Switch When Released

c. Latch When Pressed

d. Latch When Released
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Activity 2-3: Lesson Review - Answers
Refer to the figure below to answer the following quiz questions.

1. Which function executes first: Add or Subtract?

a. Add

b. Subtract

c. Unknown

2. Which function executes first: Sine or Divide?

a. Sine

b. Divide

c. Unknown

3. Which function executes first: Random Number, Divide or Add?

a. Random Number

b. Divide

c. Add

d. Unknown

4. Which function executes last: Random Number, Subtract or Add?

a. Random Number

b. Subtract

c. Add

d. Unknown

5. If an input to a function is marked with a red dot (known as coercion dot), what does the 
dot indicate?

a. Data was transferred into a structure.

b. That input has not been wired

c. The wire is broken

d. The value passed into a node was converted to a different representation.

6. Which mechanical action causes a Boolean control in the FALSE state to change to TRUE 
when you click it and stay TRUE until LabVIEW has read the value?

a. Switch Until Released

b. Switch When Released

c. Latch When Pressed

d. Latch When Released





3 Troubleshooting 
and Debugging 
VIs

In this lesson you will learn how to use LabVIEW tools to 
debug and troubleshoot VIs and how to implement basic 
error handling techniques.

Topics
+ Correcting Broken VIs

+ Debugging Techniques

+ Error Handling

Exercises
Exercise 3-1 Debugging
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A.Correcting Broken VIs
Objective: Recognize an unexecutable VI and restate common problems.

If the Run button appears broken when you finish wiring the block diagram, the VI is broken and 
cannot run.

Common Causes of Broken VIs

Example Cause

Broken wire due to 
mismatch of data 
types.

Required terminal is 
unwired.

Control wired to 
another control.

Broken subVI due to 
unwired required 
terminal.
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Identify Problems and Fix Broken VIs
Use the Error list dialog box to locate the source of errors and warnings, and get more detailed 
information about the problem.

B. Debugging Techniques
Objective: Identify the LabVIEW tools for debugging and select the tool appropriate to the 

situation.

Debugging Tips
The following table includes a few common problems to look for when debugging your VIs.

Is the numeric representation correct for your 
application?

Do nodes execute in the correct order?
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Job Aid

If a VI is not broken, but you get unexpected data, you can use the following checklist to identify 
and correct problems with the VI or the block diagram data flow:

 Wire the error in and error out parameters at the bottom of most built-in VIs and functions. 

 Select View»Error List and place a checkmark in the Show Warnings checkbox to see all 
warnings for the VI. 

 Triple-click a wire to highlight its entire path and to ensure that the wires connect to the 
proper terminals. 

 Use the Context Help window to check the default values for each function and subVI on 
the block diagram.

 Use the Find dialog box to search for subVIs, text, and other objects to correct throughout 
the VI.

 Select View»VI Hierarchy to find unwired subVIs. 

 Use execution highlighting to watch the data move through the block diagram.

 Single-step through the VI to view each action of the VI on the block diagram.

 Use the Probe tool to observe intermediate data values and to check the error output of VIs 
and functions, especially those performing I/O.

 Click the Retain Wire Values button on the block diagram toolbar to retain wire values for 
use with probes.

 Use breakpoints to pause execution, so you can single-step or insert probes.

 Suspend the execution of a subVI to edit values of controls and indicators, to control the 
number of times it runs, or to go back to the beginning of the execution of the subVI.

 Determine if the data that one function or subVI passes is undefined.

 If the VI runs more slowly than expected, confirm that you turned off execution highlighting 
in subVIs.

 Check the representation of controls and indicators to see if you are receiving overflow 
because you converted a floating-point number to an integer or an integer to a smaller 
integer. 

 Determine if any For Loops inadvertently execute zero iterations and produce empty arrays. 

 Verify you initialized shift registers properly unless you intend them to save data from one 
execution of the loop to another.

Does the VI pass undefined data?

Are there any hidden or unwired subVIs?
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 Check the cluster element order at the source and destination points. 

 Check the node execution order. 

 Check that the VI does not contain hidden subVIs. 

 Check the inventory of subVIs the VI uses against the results of View»Browse 
Relationships»This VI’s SubVIs and View»Browse Relationships»Unopened SubVIs to 
determine if any extra subVIs exist. Also open the VI Hierarchy window to see the subVIs 
for a VI. To help avoid incorrect results caused by hidden VIs, specify that inputs to VIs are 
required.

Activity 3-1: Review Debugging Tools
Goal
Select the LabVIEW debugging tool you would use for each of the following situations.

Execution Highlighting Single Stepping Probe

Situation Debugging Tool

Your VI is returning unexpected data and you 
want to see intermediate values on the wires 
to find out where the problem initiates.

Probe

You want to see how data moves from one 
node to the next on the block diagram.

You want to view each action of the VI on 
the block diagram.

This tool slows down how fast the VI runs so 
you can see the data flow through the block 
diagram.

Your block diagram is complicated and you 
need to see the intermediate data values and 
check the error output of VIs and functions, 
especially those performing I/O.

Suspend the execution of a subVI to edit 
values of controls and indicators, to control 
the number of times it runs, or to go back to 
the beginning of the execution of the subVI.
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Breakpoints
Use the Breakpoint tool to place a breakpoint on a VI, node, or wire and pause execution at that 
location.

When you reach a breakpoint during execution, the VI pauses and the Pause button appears red. 
You can take the following actions:

• Single-step through execution using the single-stepping buttons 

  

• Probe wires to check intermediate values

• Change the values of front panel controls. 

• Click the Pause button to continue running to the next breakpoint or until the VI finishes 
running.

Retain Wire Values
Retain Wire Values enables you to probe wire values after execution completes. This option uses 
more memory because LabVIEW is storing data for each wire as it runs.

Tip Always remember to turn this feature off when you are done debugging to free 
memory.
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Undefined or Unexpected Data
Floating-point operations return the following two symbolic values that indicate faulty 
computations or meaningless results.

NaN (not a number) a floating-point value that 
invalid operations produce, 
such as taking the square 
root of a negative number

Inf (infinity) a floating-point value that 
valid operations produce, 
such as dividing a number 
by zero
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C. Error Handling
Objective: Describe the difference between automatic and manual error handling.

Error Handling Review

Demonstration: Automatic vs. Manual Error Handling
• Manual error handling—Use Simple Error Handler to display errors

• Automatic error handling—Highlights the node that caused the error

Enabling automatic error handling does not override manual error handling. If the error cluster is 
wired and the VI uses the Simple Error Handler, then LabVIEW defaults to manual error handling.

Disable Automatic Error Handling
To ensure that LabVIEW doesn’t implement automatic error handling by default, disable it for 
all new VIs. Change the configuration settings in the Tools»Options dialog box.

Error Handling Anticipation, detection, and resolution of warnings and errors

Automatic 
Error Handling

At run time, LabVIEW suspends execution, highlights node where error 
occurred, and displays Error dialog box

Manual 
Error Handling

You control when dialog boxes appear, propagate errors through error 
in/error out clusters, terminate error chain with Simple Error Handler
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Error Clusters
VIs and functions return errors in one of two ways—with numeric error codes or with an error 
cluster. Typically, functions use numeric error codes, and VIs use an error cluster, usually with 
error inputs and outputs. Use the error cluster controls and indicators to create error inputs and 
outputs in subVIs. 

#

Errors and Warnings
When an error occurs, open the Explain Error dialog box to see more information about the error. 

1 status—a Boolean value that reports TRUE if an error occurs
2 code—a 32-bit signed integer that identifies the error numerically. A non-zero error code 

is coupled with a status of FALSE signals a warning rather than an error
3 source—a string that identifies where the error occurred

Errors Warnings

Status = TRUE

Code = Non-zero

Status = FALSE

Code = Non-zero

More severe Less severe

Passed to the next node without executing 
that part of the code

Node executes normally, but it is important 
to monitor warnings during development to 
ensure proper behavior of your application
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Merge Errors
The Merge Errors Function:

• Returns the first error found. If no error is found, it returns the first warning.

• Does not concatenate errors.

Use Merge Errors to

• Propagate errors along wires.

• Merge errors from different wire paths.

At the end of your application after all error sources are merged into one error cluster, you must 
report errors to the user using the Simple Error Handler VI or another error reporting mechanism.

Errors and Warnings Recommendations
By default, the Simple Error Handler VI displays a dialog with a description of any errors that 
occurred and does not report warnings. However, the Simple Error Handler VI can be configured 
for other error handling behavior. 
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Additional Resources

Learn More About LabVIEW Help Topic

Correcting Broken VIs Error List Window

Correcting Broken VIs

Using Wires to Link Block Diagram Objects

Debugging Debugging Techniques

Execution Highlighting

Single-Stepping through a VI

Using the Probe Tool

Probe Watch Window

Managing Breakpoints

Breakpoint Manager Window

Preventing Undefined Data

Error Handling Disabling Debugging Tools

Using Error Clusters

Error Codes and Messages

Merge Error Function

Displaying Warnings

Simple Error Handler VI

Handling Errors
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Activity 3-2: Lesson Review
Answer the following questions and then discuss your answers with the class.

1. Which of the following will result in a broken run arrow?

a. A subVI is broken

b. The diagram includes a divide by zero

c. A required subVI input is unwired

d. A Boolean terminal is wired to a numeric indicator

2. Which of the following are components and data types of the error cluster?

a. Status: Boolean

b. Error: String

c. Code: 32-bit integer

d. Source: String

3. All errors have negative error codes and all warnings have positive error codes.

a. True 

b. False

4. Merge Errors function concatenates error information from multiple sources.

a. True

b. False
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Activity 3-2: Lesson Review - Answers

1. Which of the following will result in a broken run arrow?

a. A subVI is broken

b. The diagram includes a divide by zero

c. A required subVI input is unwired

d. A Boolean terminal is wired to a numeric indicator

2. Which of the following are components and data types of the error cluster?

a. Status: Boolean

b. Error: String

c. Code: 32-bit integer

d. Source: String

3. All errors have negative error codes and all warnings have positive error codes.

a. True 

b. False

4. Merge Errors function concatenates error information from multiple sources.

a. True

b. False





4 Using Loops

In this lesson you will learn to recognize the different 
components of a LabVIEW loop structure and how to apply 
a For Loop or a While Loop appropriately.

Topics
+ Loops Review

+ While Loops

+ For Loops

+ Timing a VI

+ Data Feedback in Loops

+ Plotting Data

Exercises
Exercise 4-1 Pass Data Through Tunnels

Exercise 4-2 Calculating Average Temperature

Exercise 4-3 Temperature Monitor VI—Plot Multiple Temperatures
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A.Loops Review
Objective: Recognize loop structures and explain how to use them.

While Loops—Review
• Similar to Do Loop or a Repeat-Until Loop

• Repeats code segment until a condition is met

• Always execute at least once

• Iteration terminal—output that contains the number of complete iterations 

• Iteration terminal always starts at zero

• Conditional terminal sets the condition for stopping the loop

For Loops—Review
• Repeats code a certain number of times

• The value in the count terminal (an input terminal) indicates how many times to repeat the 
subdiagram in the For Loop.

• Can execute zero times

• Iteration terminal—output that contains the number of complete iterations 

1 LabVIEW While Loop 2 Flowchart 3 Pseudo Code

Code

1

Repeat (code);

Until Condition met;

End;

32

Code

End

Condition
met?

Yes

No
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• Iteration terminal always starts at zero

While Loop/For Loop Comparison

Activity 4-1: While Loops vs. For Loops
Goal
Determine when to use a While Loop and when to use a For Loop.

Description
For the following scenarios, decide whether to use a While Loop or a For Loop.

1 LabVIEW For Loop 2 Flowchart 3 Pseudo Code

While Loop For Loop

Stops executing only if the value at the 
conditional terminal meets the condition

Executes a set number of times

Must execute at least once Can execute zero times

Tunnels automatically output the last value Tunnels automatically output an array of 
data

Code

1

N=100;

i=0;

Until i=N:

    Repeat (code; i=i+1);

End;

32

N=100

i=0

i=i+1

Code

End

i=N? No

Yes
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Scenario 1 
Acquire pressure data in a loop that executes once per second for one minute.

1. If you use a While Loop, what is the condition that you need to stop the loop? 

2. If you use a For Loop, how many iterations does the loop need to run?

3. Is it easier to implement a For Loop or a While Loop?

Scenario 2 
Acquire pressure data until the pressure is greater than or equal to 1400 psi. 

1. If you use a While Loop, what is the condition that you need to stop the loop?

2. If you use a For Loop, how many iterations does the loop need to run?

3. Is it easier to implement a For Loop or a While Loop?

Scenario 3 
Acquire pressure and temperature data until both values are stable for two minutes. 

1. If you use a While Loop, what is the condition that you need to stop the loop? 

2. If you use a For Loop, how many iterations does the loop need to run?

3. Is it easier to implement a For Loop or a While Loop?

Scenario 4 
Output a voltage ramp starting at zero, increasing incrementally by 0.5 V every second, until 
the output voltage is equal to 5 V.

1. If you use a While Loop, what is the condition that you need to stop the loop? 

2. If you use a For Loop, how many iterations does the loop need to run?

3. Is it easier to implement a For Loop or a While Loop?
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Activity 4-1: While Loops vs. For Loops - Answers
Scenario 1 
Acquire pressure data in a loop that executes once per second for one minute.

1. If you use a While Loop, what is the condition that you need to stop the loop?

While Loop: Time = 1 minute

2. If you use a For Loop, how many iterations does the loop need to run?

For Loop: 60 iterations

3. Is it easier to implement a For Loop or a While Loop?

Both are possible

Scenario 2 
Acquire pressure data until the pressure is greater than or equal to 1400 psi. 

1. If you use a While Loop, what is the condition that you need to stop the loop? 

While Loop: Pressure = 1400 psi

2. If you use a For Loop, how many iterations does the loop need to run?

For Loop: unknown

3. Is it easier to implement a For Loop or a While Loop?

A While Loop. Although you can add a conditional terminal to a For Loop, you still need to 
wire a value to the count terminal. Without more information, you do not know the 
appropriate value to wire to the count terminal.

Scenario 3 
Acquire pressure and temperature data until both values are stable for two minutes. 

1. If you use a While Loop, what is the condition that you need to stop the loop?

While Loop: [(Last Temperature = Previous Temperature) for 2 minutes or more] and [(Last 
Pressure = Previous Pressure) for 2 minutes or more]

2. If you use a For Loop, how many iterations does the loop need to run?

For Loop: unknown

3. Is it easier to implement a For Loop or a While Loop?

A While Loop. Although you can add a conditional terminal to a For Loop, you still need to 
wire a value to the count terminal. Without more information, you do not know the 
appropriate value to wire to the count terminal.

Scenario 4 
Output a voltage ramp starting at zero, increasing incrementally by 0.5 V every second, until 
the output voltage is equal to 5 V.

1. If you use a While Loop, what is the condition that you need to stop the loop? 

While Loop: Voltage = 5 V
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2. If you use a For Loop, how many iterations does the loop need to run?

For Loop: 11 iterations (Including the two end points, count the iteration for each value - 
0, 0.5, 1.0, 1.5, ... 4.5, 5.0.)

3. Is it easier to implement a For Loop or a While Loop?

Both are possible.

B. While Loops
Objective: Recognize tunnels and explain their purpose on a loop structure and demonstrate 

how to use error checking and error handling inside a loop.

Tunnels
Tunnels transfer data into and out of structures. Data pass out of a loop after the loop 
terminates.

Error Checking and Error Handling
You can wire an error cluster to the conditional terminal to stop the iteration of the loop. If you 
wire the error cluster to the conditional terminal, only the TRUE or FALSE value of the status 
parameter of the error cluster passes to the terminal. If an error occurs, the loop stops. 

1 The loop executes only after data arrive at the tunnel.

1 Use the error cluster and a stop button to determine when to stop the loop.

1
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C. For Loops
Objective: Demonstrate how to add a conditional terminal to a For Loop and describe how 

numeric conversion occurs on the For Loop count terminal.

Conditional Terminal
You can add a conditional terminal to configure a For Loop to stop when a Boolean condition or 
an error occurs. A For Loop with a conditional terminal executes until the condition occurs or 
until all iterations are complete, whichever happens first. 

The following For Loop generates a random number every second until 100 seconds has passed 
or until the user clicks the stop button.

Count Terminal Numeric Conversion
If you wire a double-precision, floating-point numeric value to the count terminal, LabVIEW 
converts the numeric value to a 32-bit signed integer.

For better performance, avoid coercion by using matching data types or programmatically 
converting to matching data types.

1 Right-click the loop border and select Conditional Terminal from the shortcut menu.
2 Red glyph appears in the count terminal and a conditional terminal in the lower right corner.

1 Coercion Dot

2

1

1
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D.Timing a VI
Objective: Identify scenarios that require loop timing and apply the appropriate function

Why Do You Need Timing in a VI?
When a loop finishes executing an iteration, it immediately begins executing the next iteration, 
unless it reaches a stop condition. If you are acquiring data, and you want to acquire the data 
once every 10 seconds, you need a way to time the loop iterations so they occur once every 
10 seconds. You also want to time a loop to provide the processor with time to complete other 
tasks, such as processing the user interface.

Wait Functions Inside a Loop
Use a wait function inside a loop to accomplish the following actions:

Wait Function Behavior

Wait Until Next ms Multiple Monitors a millisecond counter and waits until the millisecond 
counter reaches a multiple of the amount you specify. This 
function is synced to the system clock.

Wait (ms) Waits until the millisecond counter counts to an amount equal 
to the input you specify

Time Delay Express VI Similar to the Wait (ms) function with the addition of built-in 
error clusters.
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Wait Function Timing
The following illustration compares the differences between two common timing functions: 
Wait Until Next ms Multiple and Wait (ms). This timing diagram assumes that the wait functions 
begin running immediately for each loop iteration and that the loop is ready to iterate as soon 
as the wait function finishes.

Elapsed Time Express VI
Determines how much time elapses after some point in your VI and keeps track of time while 
the VI continues to execute. 

Demonstration: Wait Chart VI
Compare and contrast using a Wait function and the Elapsed Time Express VI for software 
timing.

E. Data Feedback in Loops
Objective: Apply shift registers when appropriate and predict the correct value at different 

iterations of the loop.

Introduction to Shift Registers
Shift registers store data values from previous iterations of a loop in LabVIEW. 
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Shift registers are similar to static variables in text-based programming languages.

Multimedia: Using Shift Registers
When you create a shift register, the shift register reflects the data type you wire to the 
terminals. If you do not initialize the register, the loop uses the value written to the register when 
the loop last executed or it uses the default value for the data type if the loop has never 
executed. You can add more than one shift register to a loop for applications such as averaging 
data points.

Complete the multimedia module, Using Shift Registers, available in the 
<Exercises>\LabVIEW Core 1\Multimedia\ folder.

Demonstration: Creating Shift Registers
Replace tunnels with shift registers when you need to transfer values from one loop iteration to 
the next. If you convert a tunnel with auto-indexing enabled to a shift register on a While Loop, 
the wire to any node outside the loop breaks because shift registers cannot auto-index

1 Stores data at beginning of iteration 2 Stores data on completion of iteration

1 2
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F. Plotting Data
Objective: Use data feedback in a loop to plot waveform charts.

Waveform Chart
The waveform chart is a special type of numeric indicator that displays one or more plots of 
data typically acquired at a constant rate. Waveform charts can display single or multiple plots. 

Waveform Chart Properties
Waveform charts include options that you can use to customize appearance, convey more 
information, or highlight data.

1 Label
2 Y-scale

3 X-scale
4 Scale Legend

5 Graph Palette
6 Plot Legend

1
6

7

2

3

4
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You can configure how the chart updates to display new data. The chart uses the following 
modes to display data:

• Strip Chart—Shows running data continuously scrolling from left to right across the chart 
with old data on the left and new data on the right.

• Scope Chart—Shows one item of data, such as a pulse or wave, scrolling partway across 
the chart from left to right.

• Sweep Chart—Works similarly to a scope chart except it shows the old data on the right 
and the new data on the left separated by a vertical line.



Lesson 4 Using Loops

4-26 | ni.com

Ex
er

ci
se

 4
-3

 T
em

pe
ra

tu
re

 M
on

it
or

 V
I—

Pl
ot

 M
ul

ti
pl

e 
T
em

pe
ra

tu
re

s

G
oa

l
Pl

ot
 m

ul
tip

le
 d

at
a 

se
ts

 o
n 

a 
si

ng
le

 w
av

ef
or

m
 c

ha
rt

 a
nd

 c
us

to
m

iz
e 

th
e 

ch
ar

t 
vi

ew
.

S
ce

na
rio

M
od

if
y 

th
e 

V
I 
fr

om
 E

xe
rc

is
e

4
-2

 t
o 

pl
ot

 b
ot

h 
th

e 
cu

rr
en

t 
te

m
pe

ra
tu

re
 a

nd
 t

he
 r

un
ni

ng
 a

ve
ra

ge
 o

n 
th

e 
sa

m
e 

ch
ar

t.
 I
n 

ad
di

ti
on

, 
al

lo
w

 t
he

 u
se

r 
to

 e
xa

m
in

e 
a 

po
rt

io
n 

of
 t

he
 p

lo
t 

w
hi

le
 t

he
 d

at
a 

is
 b

ei
ng

 a
cq

ui
re

d.

D
es

ig
n

Fi
gu

re
4
-1

0
 s

ho
w

s 
th

e 
fr

on
t 

pa
ne

l f
or

 t
he

 e
xi

st
in

g 
T
em

pe
ra

tu
re

 M
on

it
or

 V
I 
an

d 
Fi

gu
re

4
-1

1
 s

ho
w

s 
th

e 
bl

oc
k 

di
ag

ra
m

.

Fi
gu

re
 4

-1
0
. 
 T

em
pe

ra
tu

re
 M

on
it
or

 V
I F

ro
nt

 P
an

el



LabVIEW Core 1 Participant Guide

© National Instruments | 4-27

T
o 

al
lo

w
 t

he
 u

se
r 

to
 e

xa
m

in
e 

a 
po

rt
io

n 
of

 t
he

 p
lo

t 
w

hi
le

 t
he

 d
at

a 
is

 b
ei

ng
 a

cq
ui

re
d,

 d
is

pl
ay

 t
he

 s
ca

le
 le

ge
nd

 a
nd

 t
he

 g
ra

ph
 p

al
et

te
 f

or
 t

he
 w

av
ef

or
m

 c
ha

rt
. 

A
ls

o,
 e

xp
an

d 
th

e 
le

ge
nd

 t
o 

sh
ow

 a
dd

it
io

na
l p

lo
ts

.

T
o 

m
od

if
y 

th
e 

bl
oc

k 
di

ag
ra

m
 in

 F
ig

ur
e

4
-1

1
, 
yo

u 
m

us
t 

m
od

if
y 

th
e 

ch
ar

t 
te

rm
in

al
 t

o 
ac

ce
pt

 m
ul

ti
pl

e 
pi

ec
es

 o
f 

da
ta

. 
U

se
 a

 B
un

dl
e 

fu
nc

ti
on

 t
o 

co
m

bi
ne

 t
he

 
av

er
ag

e 
te

m
pe

ra
tu

re
 a

nd
 t

he
 c

ur
re

nt
 t

em
pe

ra
tu

re
 in

to
 a

 c
lu

st
er

 t
o 

pa
ss

 t
o 

th
e 

T
em

pe
ra

tu
re

 H
is

to
ry

 t
er

m
in

al
.

Fi
gu

re
 4

-1
1
. 

 O
rig

in
al

 T
em

pe
ra

tu
re

 M
on

ito
r 

V
I B

lo
ck

 D
ia

gr
am

Im
pl

em
en

ta
ti
on

1
.

O
pe

n 
th

e 
T
em

pe
ra

tu
re

 M
on

it
or

 V
I y

ou
 c

re
at

ed
 in

 E
xe

rc
is

e
4
-2

. 


O

pe
n 
T
e
m
p
e
r
a
t
u
r
e
 
M
o
n
i
t
o
r
.
l
v
p
r
o
j
 in

 t
he

 <
E
x
e
r
c
i
s
e
s
>
\
L
a
b
V
I
E
W
C
o
r
e
1
\
T
e
m
p
e
r
a
t
u
r
e
 
M
o
n
i
t
o
r
 d

ire
ct

or
y.


O

pe
n 

T
em

pe
ra

tu
re

 M
on

it
or

.v
i f

ro
m

 t
he

 P
ro

je
ct

 E
xp

lo
re

r 
w

in
do

w
.



Lesson 4 Using Loops

4-28 | ni.com

2
.

M
od

if
y 

th
e 

bl
oc

k 
di

ag
ra

m
 s

o 
th

at
 it

 r
es

em
bl

es
 F

ig
ur

e
4
-1

2
.

Fi
gu

re
 4

-1
2
. 
 T

em
pe

ra
tu

re
 M

on
it
or

 V
I 
B
lo

ck
 D

ia
gr

am
—

Pl
ot

ti
ng

 M
ul

ti
pl

e 
T
em

pe
ra

tu
re

s

1
B
un

dl
e—

Pa
ss

es
 t

he
 c

ur
re

nt
 t

em
pe

ra
tu

re
 a

nd
 a

ve
ra

ge
 t

em
pe

ra
tu

re
 t

o 
th

e 
T
em

pe
ra

tu
re

 H
is

to
ry

 c
ha

rt
.

1



LabVIEW Core 1 Participant Guide

© National Instruments | 4-29

3
.

M
od

if
y 

th
e 

fr
on

t 
pa

ne
l s

o 
th

at
 it

 r
es

em
bl

es
 F

ig
ur

e
4
-1

3
.

Fi
gu

re
 4

-1
3
. 

 T
em

pe
ra

tu
re

 M
on

it
or

 V
I F

ro
nt

 P
an

el
—

Pl
ot

ti
ng

 M
ul

ti
pl

e 
T
em

pe
ra

tu
re

s

4
.

S
av

e 
th

e 
V

I.

T
es

t
1
.

R
un

 t
he

 V
I.
 U

se
 t

he
 t

oo
ls

 in
 t

he
 s

ca
le

 le
ge

nd
 a

nd
 t

he
 g

ra
ph

 p
al

et
te

 t
o 

ex
am

in
e 

th
e 

da
ta

 a
s 

it
 g

en
er

at
es

. 

2
.

C
lo

se
 t

he
 V

I 
an

d 
pr

oj
ec

t 
w

he
n 

yo
u 

ar
e 

fi
ni

sh
ed

.

En
d 

of
 E

xe
rc

is
e 

4
-3

1
S
ho

w
 b

ot
h 

pl
ot

s 
in

 t
he

 p
lo

t 
le

ge
nd

—
U

se
 t
he

 p
os

it
io

ni
ng

 t
oo

l t
o 

re
si

ze
 t
he

 p
lo

t 
le

ge
nd

 t
o 

sh
ow

 t
w

o 
ob

je
ct

s.
 D

ou
bl

e-
cl

ic
k 

th
e 

la
be

l t
o 

ed
it
 t
he

 p
lo

t 
na

m
es

. 
T
he

 o
rd

er
 o

f 
th

e 
pl

ot
s 

lis
te

d 
in

 t
he

 p
lo

t 
le

ge
nd

 is
 t

he
 s

am
e 

as
 t

he
 o

rd
er

 o
f 

th
e 

it
em

s 
w

ire
d 

to
 t

he
 B

un
dl

e 
fu

nc
ti
on

 o
n 

th
e 

bl
oc

k 
di

ag
ra

m
.

2
C

ha
ng

e 
th

e 
pl

ot
 t

yp
e 

of
 C

ur
re

nt
 T

em
pe

ra
tu

re
—

U
se

 t
he

 O
pe

ra
ti
ng

 t
oo

l t
o 

se
le

ct
 t

he
 p

lo
t 

in
 t

he
 p

lo
t 

le
ge

nd
. 

C
lic

k 
th

e 
pl

ot
 ic

on
, 
se

le
ct

 C
om

m
on

 P
lo

ts
 

fr
om

 t
he

 m
en

u,
 a

nd
 c

ho
os

e 
th

e 
pl

ot
 y

ou
 w

an
t.

3
D

is
pl

ay
 G

ra
ph

 P
al

et
te

—
R
ig

ht
-c

lic
k 

th
e 

T
em

pe
ra

tu
re

 H
is

to
ry

 c
ha

rt
 a

nd
 s

el
ec

t 
V

is
ib

le
 I
te

m
s»

G
ra

ph
 P

al
et

te
.

4
D

is
pl

ay
 S

ca
le

 L
eg

en
d—

R
ig

ht
-c

lic
k 

th
e 

T
em

pe
ra

tu
re

 H
is

to
ry

 c
ha

rt
 a

nd
 s

el
ec

t 
V

is
ib

le
 it

em
s»

S
ca

le
 L

eg
en

d.

41 32



Lesson 4 Using Loops

4-30 | ni.com

Additional Resources

Learn More About LabVIEW Help Topic

Using shift registers Shift Registers: Passing Values between Loop 
Iterations

Passing Multiple Values to the Next Loop Iteration
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Activity 4-2: Lesson Review

1. Which structure must run at least one time?

a. While Loop

b. For Loop
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Activity 4-2: Lesson Review - Answers

1. Which structure must run at least one time?

a. While Loop

b. For Loop





5 Creating and 
Leveraging Data 
Structures

In this lesson you will learn about arrays, clusters, and type 
definitions and be able to identify applications where using 
these data structures can be beneficial. 

Topics
+ Arrays

+ Common Array Functions

+ Polymorphism

+ Auto-Indexing

+ Clusters

+ Type Definitions

Exercises
Exercise 5-1 Manipulating Arrays

Exercise 5-2 Temperature Warnings VI—Clusters

Exercise 5-3 Temperature Warnings VI—Type Definition
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A.Arrays
Objective: Identify when to use arrays and learn how to create and initialize arrays.

Arrays

Note Array indexes in LabVIEW are zero-based. The index of the first element in 
the array, regardless of its dimension, is zero.

1D and 2D Examples
Arrays can have multiple dimensions.

• 1D array: 

For example, LabVIEW represents a text array that lists the twelve months of the year as a 
1D array of strings with twelve elements. Index is zero-based, which means the range is 0 
to n - 1, where n is the number of elements in the array. For example, n = 12 for the twelve 
months of the year, so the index ranges from 0 to 11. March is the third month, so it has 
an index of 2.

• 2D array:

For example, LabVIEW represents a table of data with rows and columns as a 2D array.

Array Collection of data elements that are of the same type.

Elements The data that make up the array. Elements can be numeric, Boolean, path, string, 
waveform, and cluster data types.

Dimension Length, height, or depth of the array. Arrays can have one or more dimensions and 
as many as (231)-1 dimensions.
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ow
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2D Arrays
A 2D array stores elements in a grid. It requires a column index and a row index to locate an 
element, both of which are zero-based. 

Initializing Arrays
An uninitialized array contains a fixed number of dimensions but no elements. An initialized 
defines the number of elements in each dimension and the contents of each element.

Demonstration: Viewing Arrays

Create an array control or indicator on the front panel by adding an array shell to the front panel, 
as shown in the following front panel, and dragging a data object or element, which can be a 
numeric, Boolean, string, path, refnum, or cluster control or indicator, into the array shell.

To create an array constant on the block diagram, select an array constant on the Functions 
palette, place the array shell on the block diagram, and place a string constant, numeric 
constant, a Boolean constant, or cluster constant in the array shell. 

Restrictions
You cannot create arrays of arrays. However, you can use a multidimensional array or create an 
array of clusters where each cluster contains one or more arrays. Also, you cannot create an 
array of subpanel controls, tab controls, .NET controls, ActiveX controls, charts, or multi-plot 
XY graphs. 

1 Uninitialized array 2 Initialized array

21
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B. Common Array Functions
Objective: Create and manipulate arrays using built-in array functions.

Multimedia: Common Array Functions
Functions you can use to manipulate arrays are located on the Array palette. 

Complete the multimedia module, Common Array Functions, available in the 
<Exercises>\LabVIEW Core 1\Multimedia\ folder.

Initialize Array
Creates an n-dimensional array in which every element is initialized to the value of element.

Insert Into Array
Inserts an element or subarray at the point you specify in index.
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Delete From Array
Deletes an element or subarray from n-dim array of length elements starting at index. Returns 
the edited array in array w/ subset deleted and the deleted element or subarray in deleted 
portion.

Array Max & Min
Returns the maximum and minimum values in array, along with the indexes for each value.

Search 1D Array
Searches for an element in a 1D array starting at start index. Because the search is linear, you 
need not sort the array before calling this function. LabVIEW stops searching as soon as the 
element is found.
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Activity 5-1: Using Array Functions
Goal: Complete the highlighted portion in each VI

Description
Each of the VIs shown has missing information. Determine what belongs in the highlighted 
section.

Block Diagram Result
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C. Polymorphism
Objective: Understand the ability of various VIs to accept input data of different data types. 

Polymorphism

Arithmetic Functions Are Polymorphic
LabVIEW arithmetic functions are polymorphic.

Polymorphism The ability of VIs and functions to automatically adapt to accept input data of 
different data types.

Functions are polymorphic to varying degrees—none, some, or all of their 
inputs can be polymorphic. 
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D.Auto-Indexing
Objective: Use auto-indexed inputs and outputs to create graphs and arrays.

Auto-Indexing 
If you wire an array to or from a For Loop or While Loop, you can link each iteration of the loop 
to an element in that array by enabling auto-indexing. The tunnel image changes from a solid 
square to the image to indicate auto-indexing. 

Waveform Graphs
A waveform graph collects the data in an array and then plots the data to the graph. 

Auto-indexing The ability to automatically process every element in an array.

1 Right-click the tunnel and select Enable Indexing or Disable Indexing to toggle the state of 
the tunnel.

2 Auto-indexed output arrays are always equal in size to the number of iterations.
3 Only one value (the last iteration) is passed out of the loop when auto-indexing is disabled.

2

1 3
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Charts vs. Graphs—Single-Plot
Charts are generally used inside the While Loop and graphs are generally outside the While Loop.

Auto-Indexing with a Conditional Tunnel
You can determine what values LabVIEW writes to the loop output tunnel based on a condition 
you specify. 

For example, consider the following block diagram. The array Input Array contains the following 
elements: 7, 2, 0, 3, 1, 9, 5, and 7. Because of the conditional tunnel, the Values less than 5 
array contains only the elements 2, 0, 3, and 1 after this loop completes all iterations.

Creating Two-Dimensional Arrays
Use two For Loops, nested one inside the other, to create a 2D array. 

1 Right-click the loop output tunnel and selecting Tunnel Mode»Conditional from the 
shortcut menu.

1 The inner loop creates the column elements and the outer loop creates the row elements.

1
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Auto-Indexing Input
Use an auto-indexing input array to perform calculations on each element in an array. If you wire 
an array to an auto-indexing tunnel on a For Loop, you do not need to wire the count (N) 
terminal.

I

Auto-Indexing Input—Different Array Sizes
If the iteration count terminal is wired and arrays of different sizes are wired to auto-indexed 
tunnels, the actual number of iterations becomes the smallest of the choices.

I

1 The For Loop executes the number of times equal to the number of elements in the array.
2 If the iteration count terminal is wired and arrays of different sizes are wired to 

auto-indexed tunnels, the actual number of iterations becomes the smallest of the choices.

1 The For Loop iterates 5 times and because the iterations are zero-based, the output is 4.

21
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E. Clusters
Objective: Identify when to use clusters and be able to create them.

Clusters

A cluster is similar to a record or a struct in text-based programming languages.An example of 
a cluster is the LabVIEW error cluster, which combines a Boolean value, a numeric value, and a 
string.

Clusters vs. Arrays

Demonstration: Create a Cluster Control 
Create a cluster control or indicator on the front panel by adding a cluster shell to the front panel 
and dragging a data object or element into the shell. The element can be a numeric, Boolean, 
string, path, refnum, array, or cluster control or indicator.

Clusters Clusters group data elements of mixed types

Cluster Array

• Mixed data types

• Fixed size

• Vary in size

• Contain only one data type
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Resize the cluster shell by dragging the cursor while you place the cluster shell.

Cluster Order
Cluster elements have a logical order unrelated to their position in the shell. The cluster order 
determines the order in which the elements appear as terminals on the Bundle and Unbundle 
functions on the block diagram. 

You can view and modify the cluster order by right-clicking the cluster border and selecting 
Reorder Controls In Cluster from the shortcut menu.
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Autosizing Clusters
Autosizing helps you arrange elements in clusters.NI recommends the following:

• Arrange cluster elements vertically.

• Arrange elements compactly.

• Arrange elements in their preferred order.

Disassembling Clusters
Use the Unbundle and Unbundle By Name functions to return individual cluster elements. 

Modifying a Cluster
Use Bundle By Name whenever possible to access elements in a cluster. Use Bundle when some 
or all cluster elements are unnamed.

I

1 Unbundle By Name—Returns the cluster elements whose names you specify. The number 
of output terminals does not depend on the number of elements in the input cluster.

2 Unbundle—Splits a cluster into its individual elements

1 2
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Demonstration: Creating a Cluster on the Block Diagram
Use the Bundle function to programmatically create a cluster on a block diagram. If the elements 
that are bundled have labels, you can access them using the Unbundle By Name function. 
Otherwise use the Unbundle function.

Multi-plot Graphs/Charts and XY Graph
The Bundle function is often used to create multi-chart plot charts and XY plots. The Build Array 
function is used to create multi-plot waveform graphs. 

Plotting Data
Use the Context Help window to determine how to wire multi-plot data to Waveform Graphs, 
Charts and XY Graphs.
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Error Clusters
LabVIEW contains a custom cluster called the error cluster. LabVIEW uses error clusters to pass 
error information. 
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F. Type Definitions
Objective: Identify and determine when to use a type definition, strict type definition, or 

control.

Control Options
Use custom controls and indicators to extend the available set of front panel objects and to 
make them available on other front panels.

Three types of custom controls—Control, Type Definition, Strict Type Definition.

Demonstration: Difference between Control, Type Def and 
Strict Type Def
• Custom controls are templates and used as starting points for other similar controls. 

Changes made to one control does not reflect in other controls.

• Type definitions and strict type definitions link to all the instances of a custom control or 
indicator to a saved custom control or indicator file. You can make changes to all instances 
of the custom control or indicator by editing only the saved custom control or indicator file

• Strict type defs apply cosmetic changes too, whereas type defs do not.



Lesson 5 Creating and Leveraging Data Structures

5-34 | ni.com

Demonstration: Creating and Identifying Type Definitions
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Additional Resources

Learn More About LabVIEW Help Topic

Arrays Adding Elements to Arrays

Changing Array Default Values

Creating Array Controls and Indicators

Default Sizes and Values of Arrays

Determining the Size of Arrays

Clusters Creating Cluster Controls and Indicators

Modifying Cluster Element Order

Moving Arrays and Clusters

Setting Cluster Default Values

Tabbing through Elements of an Array or Cluster

Type Definitions Creating Type Definitions and Strict Type Definitions
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Activity 5-2: Lesson Review

1. You can create an array of arrays.

a. True

b. False

2. You have two input arrays wired to a For Loop. Auto-indexing is enabled on both tunnels. 
One array has 10 elements, the second array has five elements. A value of 7 is wired to the 
Count terminal, as shown in the following figure. What is the value of the Iterations 
indicator after running this VI?

3. Which of the following custom control settings defines the data type of all instances of a 
control but allows for different colors and font styles?

a. Control

b. Type Definition

c. Strict Type Definition

d. Cluster control

4. You have input data representing a circle: X Position (I16), Y Position (I16), and Radius 
(I16). In the future, you might need to modify your data to include the color of the circle 
(U32).

What data structure should you use to represent the circle in your application?

a. Three separate controls for the two positions and the radius.

b. A cluster containing all of the data.

c. A custom control containing a cluster.

d. A type definition containing a cluster.

e. An array with three elements.
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Activity 5-2: Lesson Review - Answers

1. You can create an array of arrays.

a. True

b. False

You cannot drag an array data type into an array shell. However, you can create 
two-dimensional arrays.

2. You have two input arrays wired to a For Loop. Auto-indexing is enabled on both tunnels. 
One array has 10 elements, the second array has five elements. A value of 7 is wired to the 
Count terminal, as shown in the following figure. What is the value of the Iterations 
indicator after running this VI?

Value of Iterations = 4

LabVIEW does not exceed the array size. This helps to protect against programming error. 
LabVIEW mathematical functions work the same way—if you wire a 10 element array to 
the x input of the Add function, and a 5 element array to the y input of the Add function, 
the output is a 5 element array.

Although the for loop runs 5 times, the iterations are zero based, therefore the value of the 
Iterations indicators is 4.

3. Which of the following custom control settings defines the data type of all instances of a 
control but allows for different colors and font styles?

a. Control

b. Type Definition

c. Strict Type Definition

d. Cluster control

4. You have input data representing a circle: X Position (I16), Y Position (I16), and Radius 
(I16). In the future, you might need to modify your data to include the color of the circle 
(U32).

What data structure should you use to represent the circle in your application?

a. Three separate controls for the two positions and the radius.

b. A cluster containing all of the data.

c. A custom control containing a cluster.

d. A type definition containing a cluster.

e. An array with three elements.





6 Using 
Decision-Making 
Structures

In this lesson you will learn to create different 
decision-making structures and be able to identify 
applications where using these structures can be 
beneficial.

Topics
+ Case Structures

+ Event-Driven Programming

Exercises
Exercise 6-1 Temperature Warnings With Error Handling

Exercise 6-2 Converting a Polling Design to an Event Structure Design
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A.Case Structures
Objective: Recognize and use the basic features and functionality of Case Structures.

Activity 6-1: Case Structures Review
Figure 6-1.  Case Structures Review

1. What is the purpose of the Case Structure?

a. Execute one of its subdiagrams based on an input value

b. Repeat a section of code until a condition occurs

c. Execute a subdiagram a set number of times

2. How many of its cases does a Case Structure execute at a time?

a. All of them

b. One

3. What is the purpose of the Case Selector Label?

a. Lets you wire an input value to determine which case executes

b. Show the name of the current state and enable you to navigate through different cases

4. What is the purpose of the Selector Terminal?

a. Lets you wire an input value to determine which case executes

b. Show the name of the current state and enable you to navigate through different cases

1 Case Selector Label
2 Selector Terminal

1

2
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Activity 6-1: Case Structures Review - Answers
Figure 6-2.  Case Structures Review: Answers

1. What is the purpose of the Case Structure?

a. Execute one of its subdiagrams based on an input value

b. Repeat a section of code until a condition occurs

c. Execute a subdiagram a set number of times

2. How many of its cases does a Case Structure execute at a time?

a. All of them

b. One

3. What is the purpose of the Case Selector Label?

a. Lets you wire an input value to determine which case executes

b. Show the name of the current state and enable you to navigate through different cases

4. What is the purpose of the Selector Terminal?

a. Lets you wire an input value to determine which case executes

b. Show the name of the current state and enable you to navigate through different cases

Demonstration: Case Structures
Right-click the Case structure to display the shortcut menu. The shortcut menu gives you 
options for configuring a Case structure.

1 Case Selector Label 2 Selector Terminal

1

2
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Selector Terminal Data Types
You can wire a variety of data types to the Selector Terminal. The Case structure configuration 
changes based on the type of data that you connect.

Data Type Example

Boolean

A newly-created Case structure defaults to a 
Boolean input.

The Case Structure includes a True case and 
a False Case.

Integer

Case Structure has any number of cases.

Specify a Default case.

The numeric representation of the integer 
input will determine the range of possible 
values for the Case Selector Label.

You can specify ranges of values for the 
Case Selector Label. 

Use Radix option in shortcut menu to specify 
whether the Case Selector Label displays 
values in decimal, hexadecimal, octal, or 
binary.

String

Case Structure has any number of cases.

Specify a Default case.

By default, string values are case sensitive. 
Shortcut menu includes option for Case 
Insensitive Match for the string text.
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Input and Output Tunnels
As with other types of structures, you can create multiple input and output tunnels.

• Input tunnels are available to all cases if needed.

• Output tunnels require that you define a value for each case.

• Be cautious using the Use Default If Unwired option.

– Adds a level of complexity to the code.

– Can complicate debugging your code.

– The default value may not be the value that you expect.

Enum

Possible to ensure that the Case Structure 
includes a case for every item in the enum.

Right-click the border of the Case Structure 
and select Add Case for Every Value to 
create a case for every item.

Error Cluster

Case Structure includes an Error Case and a 
No Error Case.

Wire an error cluster to the terminal to 
execute code if there is no error and skip 
code if there is an error.

1 A tunnel that has been wired for all cases.
2 A tunnel that has not been wired.
3 A tunnel that is marked as Use Default If Unwired. Right-click on the tunnel and select Use 

Default if Unwired.

Data Type Example

2

1

3
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Demonstration: Selector Terminal Types and Tunnels
• Create Case structures using different data type selectors.

• Create different types of output tunnels.

Data Type Wired to Tunnel Default Value

Numeric 0

Boolean FALSE

String empty ("")



Lesson 6 Using Decision-Making Structures

6-8 | ni.com

Ex
er

ci
se

 6
-1

 T
em

pe
ra

tu
re

 W
ar

ni
ng

s 
W

it
h 

Er
ro

r 
H

an
dl

in
g

G
oa

l
M

od
if
y 

a 
V

I t
o 

us
e 

a 
C

as
e 

st
ru

ct
ur

e 
to

 m
ak

e 
a 

so
ft

w
ar

e 
de

ci
si

on
.

S
ce

na
rio

Y
ou

 c
re

at
ed

 a
 V

I 
w

he
re

 a
 u

se
r 

in
pu

ts
 a

 t
em

pe
ra

tu
re

, 
a 

m
ax

im
um

 t
em

pe
ra

tu
re

, 
an

d 
a 

m
in

im
um

 t
em

pe
ra

tu
re

. 
A

 w
ar

ni
ng

 s
tr

in
g 

ge
ne

ra
te

s 
de

pe
nd

in
g 

on
 t

he
 

re
la

ti
on

sh
ip

 o
f 

th
e 

gi
ve

n 
in

pu
ts

. 
H

ow
ev

er
, 

a 
si

tu
at

io
n 

co
ul

d 
oc

cu
r 

th
at

 c
au

se
s 

th
e 

V
I t

o 
w

or
k 

in
co

rr
ec

tl
y.

 F
or

 e
xa

m
pl

e,
 t

he
 u

se
r 

co
ul

d 
en

te
r 

a 
m

ax
im

um
 

te
m

pe
ra

tu
re

 t
ha

t 
is

 le
ss

 t
ha

n 
th

e 
m

in
im

um
 t

em
pe

ra
tu

re
. 
M

od
ify

 t
he

 V
I t

o 
ge

ne
ra

te
 a

 d
if
fe

re
nt

 s
tr

in
g 

to
 a

le
rt

 t
he

 u
se

r 
to

 t
he

 e
rr

or
: 
U
p
p
e
r
 
L
i
m
i
t
 
<
 
L
o
w
e
r
 

L
i
m
i
t
. 

S
et

 t
he

 W
ar

ni
ng

? 
in

di
ca

to
r 

to
 T

R
U

E 
to

 in
di

ca
te

 t
he

 e
rr

or
.

D
es

ig
n

M
od

if
y 

th
e 

fl
ow

ch
ar

t 
cr

ea
te

d 
fo

r 
th

e 
or

ig
in

al
 T

em
pe

ra
tu

re
 W

ar
ni

ng
s 

V
I 
as

 s
ho

w
n 

in
 F

ig
ur

e
6
-3

.

Fi
gu

re
 6

-3
. 
 M

od
if
ie

d 
T
em

pe
ra

tu
re

 W
ar

ni
ng

s 
Fl

ow
ch

ar
t

Y
ou

 m
us

t 
ad

d 
a 

C
as

e 
st

ru
ct

ur
e 

to
 t

he
 T

em
pe

ra
tu

re
 W

ar
ni

ng
s 

V
I 
to

 e
xe

cu
te

 t
he

 c
od

e 
if
 t

he
 m

ax
im

um
 t

em
pe

ra
tu

re
 is

 le
ss

 t
ha

n 
or

 e
qu

al
 t

o 
th

e 
m

in
im

um
 

te
m

pe
ra

tu
re

. 
O

th
er

w
is

e,
 t

he
 V

I d
oe

s 
no

t 
ex

ec
ut

e 
th

e 
co

de
. 
In

st
ea

d,
 t

he
 V

I 
ge

ne
ra

te
s 

a 
ne

w
 s

tr
in

g 
an

d 
th

e 
W

ar
ni

ng
? 

in
di

ca
to

r 
is

 s
et

 t
o 

T
R
U

E.

Ye
s

Ye
s

C
re

at
e 

E
rr

or

O
ut

pu
t

U
pp

er
 L

im
it

<
 L

ow
er

 L
im

it
an

d 
T

R
U

E

O
ut

pu
t

H
ea

ts
tr

ok
e 

W
ar

ni
ng

 a
nd

T
R

U
E

Ye
s

O
ut

pu
t

Fr
ee

ze
 W

ar
ni

ng
 

an
d

T
R

U
E

M
in

 T
em

p 
>

=
M

ax
 T

em
p

N
o

M
in

 T
em

p 
  

M
ax

 T
em

p
M

in
 T

em
p 

>
=

M
ax

 T
em

p

N
o

C
ur

re
nt

 T
em

p
   

 M
ax

 T
em

p
N

o
O

ut
pu

t 
N

o 
W

ar
ni

ng
 

an
d

F
A

LS
E

C
ur

re
nt

 T
em

p
   

 M
in

 T
em

p



LabVIEW Core 1 Participant Guide

© National Instruments | 6-9

Fi
gu

re
 6

-4
. 

 O
rig

in
al

 T
em

pe
ra

tu
re

 W
ar

ni
ng

s 
V

I B
lo

ck
 D

ia
gr

am

Im
pl

em
en

ta
ti
on

1
.

O
pe

n 
W
e
a
t
h
e
r
 
W
a
r
n
i
n
g
s
.
l
v
p
r
o
j
 in

 t
he

 <
E
x
e
r
c
i
s
e
s
>
\
L
a
b
V
I
E
W
 
C
o
r
e
 
1
\
W
e
a
t
h
e
r
 
W
a
r
n
i
n
g
s
 d

ire
ct

or
y.

 

2
.

O
pe

n 
T
em

pe
ra

tu
re

 W
ar

ni
ng

s.
vi

 f
ro

m
 t

he
 P

ro
je

ct
 E

xp
lo

re
r 

w
in

do
w

. 

3
.

O
pe

n 
th

e 
bl

oc
k 

di
ag

ra
m

 a
nd

 c
re

at
e 

sp
ac

e 
to

 a
dd

 t
he

 C
as

e 
st

ru
ct

ur
e.

 


S
el

ec
t 

th
e 

W
ea

th
er

 D
at

a 
In

 t
yp

e-
de

fi
ne

d 
cl

us
te

r 
te

rm
in

al
, 

th
e 

U
nb

un
dl

e 
by

 N
am

e 
fu

nc
ti
on

, 
an

d 
th

e 
Er

ro
r 

In
 t

er
m

in
al

.

T
ip

T
o 

se
le

ct
 m

or
e 

th
an

 o
ne

 it
em

 p
re

ss
 t

he
 <

S
hi

ft
>

 k
ey

 w
hi

le
 y

ou
 s

el
ec

t 
th

e 
it
em

s.


W

hi
le

 t
he

 o
bj

ec
ts

 a
re

 s
ti
ll 

se
le

ct
ed

, 
us

e 
th

e 
le

ft
 a

rr
ow

 k
ey

 o
n 

th
e 

ke
yb

oa
rd

 t
o 

m
ov

e 
th

e 
co

nt
ro

ls
 t

o 
th

e 
le

ft
.

T
ip

Pr
es

s 
an

d 
ho

ld
 t

he
 <

S
hi

ft
>

 k
ey

 t
o 

m
ov

e 
th

e 
ob

je
ct

s 
in

 f
iv

e 
pi

xe
l i

nc
re

m
en

ts
.

T
ip

Pr
es

s 
th

e 
<

C
tr

l>
 k

ey
 a

nd
 u

se
 t

he
 P

os
it
io

ni
ng

 t
oo

l t
o 

dr
ag

 o
ut

 a
 r

eg
io

n 
of

 t
he

 s
iz

e 
yo

u 
w

an
t 

to
 in

se
rt

.


S
el

ec
t 

th
e 

W
ea

th
er

 D
at

a 
O

ut
 t

yp
e-

de
fi
ne

 c
lu

st
er

 t
er

m
in

al
, 

th
e 

B
un

dl
e 

by
 N

am
e 

fu
nc

ti
on

, 
an

d 
th

e 
Er

ro
r 

O
ut

 t
er

m
in

al
.



Lesson 6 Using Decision-Making Structures

6-10 | ni.com


W

hi
le

 t
he

 t
er

m
in

al
s 

ar
e 

st
ill

 s
el

ec
te

d,
 u

se
 t

he
 r

ig
ht

 a
rr

ow
 k

ey
 o

n 
th

e 
ke

yb
oa

rd
 t

o 
m

ov
e 

th
e 

in
di

ca
to

rs
 t

o 
th

e 
rig

ht
.


S
el

ec
t 

th
e 

w
ire

 c
on

ne
ct

in
g 

th
e 

W
ea

th
er

 D
at

a 
In

 t
er

m
in

al
 a

nd
 t

he
 B

un
dl

e 
by

 N
am

e 
fu

nc
ti
on

.


W

hi
le

 t
he

 w
ire

 is
 s

ti
ll 

se
le

ct
ed

, 
us

e 
th

e 
up

 a
rr

ow
 k

ey
 o

n 
th

e 
ke

yb
oa

rd
 t

o 
m

ov
e 

th
e 

w
ire

 u
pw

ar
d.

4
.

M
od

if
y 

th
e 

bl
oc

k 
di

ag
ra

m
 s

im
ila

r 
to

 t
ha

t 
sh

ow
n 

in
 F

ig
ur

e
6
-5

, 
Fi

gu
re

6
-6

, 
an

d 
Fi

gu
re

6
-7

. 
T
hi

s 
V

I 
is

 p
ar

t 
of

 t
he

 t
em

pe
ra

tu
re

 w
ea

th
er

 s
ta

ti
on

 p
ro

je
ct

.

Fi
gu

re
 6

-5
. 

 T
em

pe
ra

tu
re

 W
ar

ni
ng

s 
V

I 
B
lo

ck
 D

ia
gr

am
—

N
o 

Er
ro

r,
 F

al
se

 C
as

e

1
Le

ss
?—

C
om

pa
re

s 
th

e 
M

ax
 T

em
pe

ra
tu

re
 a

nd
 M

in
 T

em
pe

ra
tu

re
. 
M

ak
e 

su
re

 t
he

 L
es

s?
 f

un
ct

io
n 

is
 o

ut
si

de
 t

he
 C

as
e 

st
ru

ct
ur

e.
2

C
as

e 
S
tr

uc
tu

re
—

D
o 

no
t 

in
cl

ud
e 

th
e 

W
ea

th
er

 D
at

a 
In

, 
Er

ro
r 

In
, 
W

ea
th

er
 D

at
a 

O
ut

, 
or

 E
rr

or
 O

ut
 t

er
m

in
al

s 
in

 t
he

 C
as

e 
st

ru
ct

ur
e 

be
ca

us
e 

th
es

e 
co

nt
ro

ls
 

an
d 

in
di

ca
to

rs
 a

re
 u

se
d 

by
 b

ot
h 

ca
se

s.
3

S
et

 T
ru

e 
an

d 
Fa

ls
e 

ca
se

s—
W

it
h 

th
e 

T
ru

e 
ca

se
 v

is
ib

le
, 

rig
ht

-c
lic

k 
th

e 
bo

rd
er

 o
f 

th
e 

C
as

e 
st

ru
ct

ur
e 

an
d 

se
le

ct
 M

ak
e 

th
is

 C
as

e 
Fa

ls
e.

4
C

as
e 

S
tr

uc
tu

re
—

W
ire

 t
he

 E
rr

or
 In

 t
er

m
in

al
 t
o 

th
e 

se
le

ct
or

 t
er

m
in

al
 t
o 

cr
ea

te
 N

o 
Er

ro
r 
an

d 
Er

ro
r 
ca

se
s.

 B
y 

de
fa

ul
t,

 t
he

 C
as

e 
st

ru
ct

ur
e 

ha
s 

T
ru

e 
an

d 
Fa

ls
e 

ca
se

s.
 T

he
se

 c
as

es
 c

ha
ng

e 
to

 E
rr

or
 a

nd
 N

o 
Er

ro
r 

ca
se

s 
on

ly
 a

ft
er

 y
ou

 w
ire

 E
rr

or
 In

 t
o 

th
e 

se
le

ct
or

 t
er

m
in

al
.

1

3

2

4



LabVIEW Core 1 Participant Guide

© National Instruments | 6-11

Fi
gu

re
 6

-6
. 

 T
em

pe
ra

tu
re

 W
ar

ni
ng

s 
V

I—
N

o 
Er

ro
r,

 T
ru

e 
C

as
e

5
.

Pr
ed

ic
t 

th
e 

va
lu

es
 f

or
 T

em
pe

ra
tu

re
 W

ar
ni

ng
 T

ex
t 

an
d 

T
em

pe
ra

tu
re

 W
ar

ni
ng

? 
gi

ve
n 

ea
ch

 s
et

 o
f 

in
pu

ts
.

1
T
ru

e 
ca

se
—

If
 t

he
 M

ax
 T

em
pe

ra
tu

re
 is

 s
et

 lo
w

er
 t

ha
n 

th
e 

M
in

 T
em

pe
ra

tu
re

, 
th

e 
T
ru

e 
ca

se
 e

xe
cu

te
s.

 C
lic

k 
th

e 
ca

se
 s

el
ec

to
r 

la
be

l t
o 

ch
oo

se
 t

he
 T

ru
e 

ca
se

.
2

T
ru

e 
C

on
st

an
t—

W
he

n 
th

e 
T
ru

e 
ca

se
 e

xe
cu

te
s,

 t
he

 T
em

pe
ra

tu
re

 W
ar

ni
ng

? 
LE

D
 il

lu
m

in
at

es
 in

 t
he

 W
ea

th
er

 D
at

a 
O

ut
 c

lu
st

er
. 

3
S
tr

in
g 

C
on

st
an

t—
If
 t

he
 M

ax
 T

em
pe

ra
tu

re
 is

 s
et

 lo
w

er
 t

ha
n 

th
e 

M
in

 T
em

pe
ra

tu
re

, 
th

e 
w

ar
ni

ng
 U
p
p
e
r
 
L
i
m
i
t
 
<
 
L
o
w
e
r
 
L
i
m
i
t
 d

is
pl

ay
s 

on
 t

he
 f

ro
nt

 
pa

ne
l. 

En
te

r 
th

e 
te

xt
 in

 t
he

 S
tr

in
g 

C
on

st
an

t.

T
ab

le
 6

-1
. 
 P

re
di

ct
 V

al
ue

s 
fo

r 
T
em

pe
ra

tu
re

 W
ar

ni
ng

s 
V

I

C
ur

re
nt

 T
em

pe
ra

tu
re

M
ax

 T
em

pe
ra

tu
re

M
in

 T
em

pe
ra

tu
re

T
em

pe
ra

tu
re

 W
ar

ni
ng

 T
ex

t
T
em

pe
ra

tu
re

 W
ar

ni
ng

?

3
0

3
0

1
0

2
5

3
0

1
0

1
0

3
0

1
0

2
5

2
0

3
0

1 32



Lesson 6 Using Decision-Making Structures

6-12 | ni.com

6
.

C
re

at
e 

th
e 

Er
ro

r 
ca

se
 in

 t
he

 o
ut

er
 C

as
e 

st
ru

ct
ur

e 
so

 t
hi

s 
V

I 
ca

n 
be

 u
se

d 
as

 a
 s

ub
V

I.

Fi
gu

re
 6

-7
. 
 T

em
pe

ra
tu

re
 W

ar
ni

ng
s 

V
I—

Er
ro

r 
C

as
e

7
.

S
av

e 
th

e 
V

I.

T
es

t
1
.

S
w

it
ch

 t
o 

th
e 

fr
on

t 
pa

ne
l o

f 
th

e 
V

I. 

2
.

T
es

t 
th

e 
V

I b
y 

en
te

rin
g 

va
lu

es
 f
ro

m
 T

ab
le

6
-2

 in
 t
he

 C
ur

re
nt

 T
em

pe
ra

tu
re

, 
M

ax
T
em

pe
ra

tu
re

, 
an

d 
M

in
 T

em
pe

ra
tu

re
 c

on
tr

ol
s 

an
d 

ru
nn

in
g 

th
e 

V
I f

or
 e

ac
h 

se
t 

of
 d

at
a.



LabVIEW Core 1 Participant Guide

© National Instruments | 6-13

T
ab

le
6
-2

 s
ho

w
s 

th
e 

ex
pe

ct
ed

 T
em

pe
ra

tu
re

 W
ar

ni
ng

 T
ex

t 
an

d 
T
em

pe
ra

tu
re

 W
ar

ni
ng

? 
B
oo

le
an

 v
al

ue
 f

or
 e

ac
h 

se
t 

of
 d

at
a.


D

o 
th

es
e 

va
lu

es
 m

at
ch

 t
he

 v
al

ue
s 

th
at

 y
ou

 p
re

di
ct

ed
?


W

ha
t 

ha
pp

en
s 

if
 y

ou
 s

et
 t

he
 v

al
ue

 f
or

 a
ll 

th
re

e 
in

pu
ts

 t
o 

1
0
?


H

ow
 c

ou
ld

 y
ou

 a
dd

re
ss

 t
hi

s 
pr

ob
le

m
?

3
.

T
es

t 
th

e 
Er

ro
r 

ca
se

. 
T
o 

us
e 

th
is

 V
I a

s 
a 

su
bV

I,
 t

he
 V

I m
us

t 
be

 a
bl

e 
to

 h
an

dl
e 

an
 e

rr
or

 c
om

in
g 

in
to

 t
he

 V
I.
 T

es
t 

th
e 

Er
ro

r 
ca

se
 t

o 
m

ak
e 

su
re

 t
ha

t 
th

is
 V

I 
ca

n 
ou

tp
ut

 t
he

 e
rr

or
 in

fo
rm

at
io

n 
it
 r

ec
ei

ve
s.


O

n 
th

e 
fr

on
t 

pa
ne

l, 
us

e 
th

e 
O

pe
ra

ti
ng

 t
oo

l t
o 

cl
ic

k 
th

e 
st

at
us

 B
oo

le
an

 in
di

ca
to

r 
in

si
de

 t
he

 E
rr

or
 In

 c
lu

st
er

 s
o 

th
at

 t
he

 in
di

ca
to

r 
tu

rn
s 

re
d 

an
d 

en
te

r 
7
 

in
 t

he
 c

od
e 

co
nt

ro
l.


R
un

 t
he

 V
I.
 T

he
 e

rr
or

 in
fo

rm
at

io
n 

yo
u 

en
te

re
d 

pa
ss

es
 t

hr
ou

gh
 t

he
 E

rr
or

 c
as

e 
in

 t
he

 V
I a

nd
 is

 o
ut

pu
t 

in
 t

he
 E

rr
or

 O
ut

 c
lu

st
er

. 


D

is
pl

ay
 t

he
 b

lo
ck

 d
ia

gr
am

, 
se

le
ct

 t
he

 N
o 

Er
ro

r 
ca

se
, 

hi
gh

lig
ht

 e
xe

cu
ti
on

, 
an

d 
th

en
 r

un
 t

he
 V

I 
ag

ai
n 

to
 s

ee
 t

he
 e

rr
or

 p
as

s 
th

ro
ug

h 
th

e 
Er

ro
r 

ca
se

.


O

n 
th

e 
fr

on
t 

pa
ne

l, 
rig

ht
-c

lic
k 

th
e 

bo
rd

er
 o

f 
th

e 
Er

ro
r 

O
ut

 c
lu

st
er

 a
nd

 s
el

ec
t 

Ex
pl

ai
n 

Er
ro

r 
to

 d
is

pl
ay

 in
fo

rm
at

io
n 

ab
ou

t 
th

e 
er

ro
r 

th
at

 w
as

 r
et

ur
ne

d.

4
.

S
av

e 
an

d 
cl

os
e 

th
e 

V
I.

En
d 

of
 E

xe
rc

is
e 

6
-1

T
ab

le
 6

-2
. 

 T
es

ti
ng

 V
al

ue
s 

fo
r 

T
em

pe
ra

tu
re

 W
ar

ni
ng

s 
V

I

C
ur

re
nt

 T
em

pe
ra

tu
re

M
ax

 T
em

pe
ra

tu
re

M
in

 T
em

pe
ra

tu
re

T
em

pe
ra

tu
re

 W
ar

ni
ng

 T
ex

t
T
em

pe
ra

tu
re

 W
ar

ni
ng

?

3
0

3
0

1
0

H
e
a
t
s
t
r
o
k
e
 
W
a
r
n
i
n
g

T
ru

e

2
5

3
0

1
0

N
o
 
W
a
r
n
i
n
g

Fa
ls

e

1
0

3
0

1
0

F
r
e
e
z
e
 
W
a
r
n
i
n
g

T
ru

e

2
5

2
0

3
0

U
p
p
e
r
 
L
i
m
i
t
 
<
 
L
o
w
e
r
 
L
i
m
i
t

T
ru

e



Lesson 6 Using Decision-Making Structures

6-14 | ni.com

B. Event-Driven Programming
Objective: Recognize basic features and functionality of event structures.

Demonstration: Event-Driven Scenario

Polling Versus Events

Event-driven 
programming

Method of programming where the program waits on an event to occur before 
executing the code written to handle that event.

Event An asynchronous notification that something has occurred. Events can 
originate from the user interface, external I/O, or other parts of the program. In 
this course, you will only learn about user interface events, which include 
mouse clicks, key presses, and value changes of a control.

Polling Event
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Multimedia: Event-Driven Programming
Complete the multimedia module, Event-Driven Programming, available in the <Exercises>\
LabVIEW Core 1\Multimedia\ folder to learn about programming with events.

Configuring the Event Structure
You can select which events the Event structure implements by right-clicking the border and 
selecting Edit Events Handled by This Case from the shortcut menu
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Edit Events Dialog Box

Notify and Filter Events
LabVIEW categorizes user interface events into two different types of events:

• Notify—(Green arrow) Notify events inform you that a user action occurred. LabVIEW has 
already performed the default action associated with that event.

• Filter—(Red arrow) Filter events allow you to validate or change the event data before 
LabVIEW performs the default action associated with that event. You also can discard the 
event entirely to prevent the change from affecting the VI.

Note A single case in the Event structure cannot handle both notify and filter 
events. A case can handle multiple notify events but can handle multiple filter events 
only if the event data items are identical for all events.

1 Configured events 2 Event sources 3 Events

1 2 3
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Demonstration: Configure and Use Events
Configure and use an Event structure to create a VI that responds to user interface events using 
event-driven programming.
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Caveats and Recommendations
The following list describes some of the caveats and recommendations to consider when 
incorporating events into LabVIEW applications.

• Place only one Event structure in a loop.

• Use a Value Change event to detect value changes.

• Keep event handling code short and quick.

• Place Boolean control terminals inside an event case for latched operations to work 
properly.

• Avoid using an Event structure outside of a loop.

• Avoid configuring two Event structures for the same event.

Think about the VIs that you will need to develop at your job.
Will you use event-based programming to implement any of your VIs? Why or why not?

Additional Resources

Learn More About LabVIEW Help Topic or ni.com

Event-driven programming Locking Front Panels

Choosing How the Event Structure Monitors For 
Events

Viewing Enqueued Events at Run Time

Event-Driven Programming

Events in LabVIEW

Deciding whether to use events Caveats and Recommendations when Using Events in 
LabVIEW

Part of the Event structure Event Structure

Configuring Events Handled by the Event Structure

Determining which notifier to use Determining Which Type of User Interface Events to 
Use
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Activity 6-2: Lesson Review
1. Which of the following can NOT be used as the case selector input to a Case structure?

a. Error cluster

b. Array

c. Enum

d. String

2. How many events can an Event structure handle each time it executes?

a. As many as have occurred since the last time the event structure executed

b. One per configured event case

c. One

3. Which statements about event-driven programming versus polling are true?

a. Events execute on demand.

b. Event-driven programming is less CPU-intensive.

c. Event structures handle all events in the order the occur.

d. Polling may fail to detect a change.
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Activity 6-2: Lesson Review - Answers
1. Which of the following can NOT be used as the case selector input to a Case structure?

a. Error cluster

b. Array

c. Enum

d. String

2. How many events can an Event structure handle each time it executes?

a. As many as have occurred since the last time the event structure executed

b. One per configured event case

c. One

3. Which statements about event-driven programming versus polling are true?

a. Events execute on demand.

b. Event-driven programming is less CPU-intensive.

c. Event structures handle all events in the order the occur.

d. Polling may fail to detect a change.





7 Modularity

In this lesson you will learn to recognize the benefits of 
reusing code and will be able to create a subVI with a 
properly configured connector pane, meaningful icon, 
documentation, and error handling.

Topics
+ Understanding Modularity

+ Icon

+ Connector Pane

+ Documentation

+ Using SubVIs

Exercises
Exercise 7-1 Temperature Warnings VI—As SubVI
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A.Understanding Modularity
Objective: Recognize the benefit of using modular code and identify sections of code that 

could be reused.

Modularity and SubVIs

SubVIs—Reusing Code
SubVIs are similar to a subroutine in text-based programming languages. Use subVIs when you 
have code that performs identical operations on different parts of your block diagram or in 
another VI.

Modularity The degree to which a program is composed of discrete modules such that a 
change tonne module has minimal impact on other modules. Modules in LabVIEW 
are called subVIs.

SubVI A VI used within another VI.The degree to which a program is composed of 
discrete modules such that a change tonne module has minimal impact on other 
modules. Modules in LabVIEW are called subVIs.
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SubVIs
The following pseudo-code and block diagrams demonstrate the analogy between subVIs and 
subroutines.

B. Icon
Objective: Recognize characteristics of a good icon and use the LabVIEW Icon Editor to 

create a custom icon.

Purpose of Icon
This icon displayed in the upper right corner of the front panel is the same as the icon that 
appears when you place the VI on the block diagram. 

Function Code Calling Program Code

function average (in1, in2, out)
{
out = (in1 + in2)/2.0;
}

main
{
average (point1, point2, pointavg)
}

SubVI Block Diagram Calling VI Block Diagram

Icon A VI icon is a graphical representation of a VI. It can contain text, images, or a 
combination of both. If you use a VI as a subVI, the icon identifies the subVI on the 
block diagram of the VI.
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Characteristics of a Good Icon
A good icon conveys the functionality of the VI by using relevant graphics and text. You can 
also uses banners to identify related VIs.

Creating Icons—Icon Editor
Use the Icon Editor dialog box to edit a VI icon. You can customize your icon with text, graphics 
from the glyphs library, and banners. Additionally, you can create and save custom templates. 

Demonstration: Creating an Icon
Using the LabVIEW Icon Editor, the instructor will demonstrate how to use the templates, icon 
text, glyphs, and layers to create an icon.
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C.Connector Pane
Objective: Select and configure a connector pane for a subVI.

Patterns

A connector pane receives data at its input terminals and passes the data to the block diagram 
code through the front panel controls and receives the results at its output terminals from the 
front panel indicators. The connector pane is displayed next to the icon on the front panel 
window. You can select from many different patterns depending on how many inputs and 
outputs are required.

Connector Pane A set of terminals that correspond to the controls and indicators of that VI, 
similar to the parameter list of a function call in text-based programming 
languages. The connector pane defines the inputs and outputs you can wire 
to the VI so you can use it as a subVI.
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Assigning Terminals
Click the connector pane terminal and then click the front panel control or indicator to assign 
the terminal. 

Standards
The standard connector pane, shown in the following figure is 4 x 2 x 2 x 4. 

Use the following guidelines when assigning connector pane terminals:

• References on the top

• Error clusters on the bottom

• Inputs on the left

• Outputs on the right

• Unused terminals can be assigned later if you modify the VI

1 Current Temperature
2 Max Temperature
3 Min Temperature

4 Error In
5 Warning?

6 Warning Text
7 Error Out

1

2

3

5

6

74



Lesson 7 Modularity

7-8 | ni.com

D.Documentation
Objective: Explain how to document code in LabVIEW using descriptions and tip strips, and 

describe four methods for documenting code on the block diagram.

Creating Descriptions and Tip Strips
Create descriptions and tip strips for front panel objects in the properties dialog box for the 
object. Create descriptions for VIs on the Documentation page of the in the VI Properties dialog 
box.

1 Descriptions appear in the Context Help window.
2 Tip strips display when the cursor is over an object while the VI runs

1 Descriptions appear in the Context Help window.

1

2

1
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Documenting Block Diagram Code

E. Using SubVIs
Objective: Demonstrate how to place subVIs on the block diagram, explain terminal settings 

and error handling, and create subVIs from a section of existing code.

Placing SubVIs on the Block Diagram
Place a SubVI on the block diagram in one of the following ways:

• Click Select a VI on the Functions palette.

• Drag the VI from the Project Explorer Window.

• Drag the Icon from an open VI.

• Use Quick Drop to search for the VI by name.

1 Free label
2 Owned label

1

2
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Terminal Settings
You can designate which inputs and outputs are required, recommended, and optional to 
prevent users from forgetting to wire subVI terminals. LabVIEW sets inputs and outputs of VIs 
you create to Recommended by default. Set a terminal to required only if the VI must have the 
input to run properly.

In the Context Help window, terminal labels appear differently depending on their setting.

Handling Errors
Use a Case structure to handle errors passed into the subVI.

Appearance Meaning Description

Bold Required The block diagram containing the subVI will be broken 
if you do not wire the required inputs.

Plain Recommended The block diagram containing the subVI can execute 
if you do not wire the recommended or optional 
terminals. If you do not wire the terminals, the VI 
does not generate any warnings.

Dimmed Optional
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Avoid using LabVIEW error handler VIs inside subVIs.

Convert a Section of a VI to a SubVI
Simplify your block diagram by converting sections of the block diagram into subVIs.

1. Select the section of the block diagram to convert.

2. Select Edit»Create SubVI.

3. Double-click the icon to open the subVI and edit the icon and connector pane.
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Additional Resources

Learn More About LabVIEW Help Topic or ni.com

SubVIs Creating SubVIs

Customizing VIs

Placing SubVIs on Block Diagrams

Icons Using Icons

Creating Icons

Documentation Creating Object Descriptions and Tip Strips

Creating Documentation

Creating and Editing VI Descriptions
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Activity 7-1: Lesson Review
1. On a subVI, which terminal setting causes a broken VI if the terminal is not wired?

a. Required

b. Recommended

c. Optional

2. You must create a custom icon to use a VI as a subVI.

a. True

b. False 





LabVIEW Core 1 Participant Guide

© National Instruments | 7-21

Activity 7-1: Lesson Review - Answers
1. On a subVI, which terminal setting causes a broken VI if the terminal is not wired?

a. Required

b. Recommended

c. Optional

2. You must create a custom icon to use a VI as a subVI.

a. True

b. False 

You do not need to create a custom icon to use a VI as a subVI, but it is highly 
recommended to increase the readability of your code. 





8 Acquiring 
Measurements 
from Hardware

In this lesson you will learn about the differences between 
NI DAQ systems and instrument control and how LabVIEW 
connects to hardware to get real-world measurements.

Topics
+ Measurement Fundamentals with NI DAQ Hardware

+ Automating Non-NI Instruments

Exercises
Exercise 8-1 Using NI MAX to Examine a DAQ Device

Exercise 8-2 Programming with the DAQmx API

Exercise 8-3 Instrument Configuration with NI MAX

Exercise 8-4 Exploring Instrument Drivers
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A.Measurement Fundamentals with NI DAQ 
Hardware
Objective: Recognize the components of a DAQ system and practice connecting to 

hardware.

DAQ—Measuring Physical Phenomenon with a Computer
By using NI DAQ systems and LabVIEW, you can customize all aspects of data collection.

Multimedia: Measurement Fundamentals with NI DAQ
Complete the multimedia module, Measurement Fundamentals with NI DAQ, available in the 
<Exercises>\LabVIEW Core 1\Multimedia\ folder to learn how to acquire different types 
of measurements using LabVIEW and an NI DAQ device.

Data acquisition The process of measuring an electrical or physical phenomenon with a 
computer. A DAQ system consist of a sensor, NI DAQ device, and a 
computer running LabVIEW.

DAQ Device Computer

Signal
Conditioning

Driver
Software

Application
Software

Analog-to-Digital
Converter

Sensor

Bus

LabVIEWDAQmx
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The following table lists common sensors and the phenomenon they measure.

You can group real-world signals as analog, digital or counters.

Sensor Phenomenon

Thermocouple, RTD, thermistor Temperature

Photo sensor Light

Microphone Sound

Strain gage, piezoelectric transducer Force and Pressure

Potentiometer, LVDT, optical encoder Position and Displacement

Accelerometer Acceleration

pH probe pH

Signal Type Description Examples

Analog Signals that vary continuously Temperature, current

Digital Electrical signals that transfer binary data, 
such as on/off or true/false.

LEDs, switches

Counter Digital timing signal that includes 
characteristics of a digital signal that can be 
counted or measured, such as rising edges, 
frequency of edges occurring, and 
pulse-width.

Event counting, period 
measurement, position 
measurement
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Exercise 8-1 Using NI MAX to Examine a DAQ 
Device

Goal
Use MAX to examine, configure, and test a device.

Implementation
Complete the following steps to examine the configuration for the DAQ device in the computer 
using MAX. Use the test routines in MAX to confirm operation of the device. If you do not have 
a DAQ device, you can simulate a device using the instructions in step 3.

Note Portions of this exercise can only be completed with the use of a real device 
and a BNC-2120, shown in Figure 8-1. Some of these steps have alternative 
instructions for simulated devices.

1. Launch MAX by selecting Start»Programs»NI MAX or by double-clicking the NI MAX icon 
on your desktop. MAX searches the computer for installed National Instruments hardware 
and displays the information.

2. If you have a DAQ device installed, skip step 3 and go to the Examining the DAQ Device 
Settings section.

3. Create an NI-DAQmx simulated device to allow you to complete the exercises without 
hardware. 

 Right-click Devices and Interfaces and select Create New from the shortcut menu. 

 In the Create New dialog box, select Simulated NI-DAQmx Device or Modular 
Instrument.

 Click the Finish button.

 In the Create Simulated NI-DAQmx Device dialog box, select M Series DAQ»
NI PCI 6225.

 Click the OK button.
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BNC-2120 Terminal Block
A terminal block consists of screw or spring terminals for connecting signals or other sensors. 
A cable transports the signal from the terminal block to the DAQ device. 

Figure 8-1.  BNC-2120

1 RES/BNC Switch (AI 3)
2 Resistor Measurement Screw Terminals
3 Thermocouple Input Connector
4 Temperature Reference
5 BNC/Temp. Ref. Switch (AI 0)
6 BNC/Thermocouple Switch (AI 1)
7 Analog Input BNC Connectors
8 FS/GS Switches
9 Analog Output BNC Connector
10 Frequency Range Selection Switch
11 Sine/Triangle BNC Connector
12 TTL Square Wave BNC Connector

13 Sine/Triangle Waveform Switch
14 Frequency Adjust Knob
15 Amplitude Adjust Knob
16 Digital I/O Screw Terminals
17 Digital I/O LEDs
18 User-Defined Screw Terminals
19 User-Defined BNC Connectors
20 Timing I/O Screw Terminals
21 Quadrature Encoder Screw Terminals
22 Quadrature Encoder Knob
23 Timing I/O BNC Connector
24 Power Indicator LED
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STN_+ Floating
Source (FS) _+Ground Ref.

Source (GS)

AO

ANALOG OUTPUTS

ANALOG INPUTS
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Examining the DAQ Device Settings
1. Expand the Devices and Interfaces section.

2. Select the device that is connected to your machine. Green icons represent real devices and 
yellow icons represent simulated devices. You might have a different device installed, and 
some of the options shown might be different. 

MAX displays National Instruments hardware and software in the computer. The device 
alias appears in quotes following the device type. The Data Acquisition VIs use this device 
alias to determine which device performs DAQ operations. MAX also displays the attributes 
of the device such as the system resources that the device uses. Figure 8-2 shows the 
simulated PCI-6225 device.

Make sure the device you use is named Dev 1. To rename a device, right-click the device 
and select Rename from the shortcut menu.

Figure 8-2.  MAX with Device and Interfaces Expanded

Tip The Show Help/Hide Help button in the top right corner of MAX is available for 
certain items. Click the Show Help/Hide Help button to hide online help or show the 
DAQ device information. 

3. Select the Device Routes tab at the bottom of MAX to see detailed information about the 
internal signals that can be routed to other destinations on the device, as shown in 
Figure 8-3. This is a powerful resource that gives you a visual representation of the signals 
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that are available to provide timing and synchronization with components that are on the 
device and other external devices.

Figure 8-3.  Device Routes

4. Select the Settings tab, as shown in Figure 8-4, to see information about the last time the 
device was calibrated both internally and externally. Not all devices contain calibration 
information. 

Figure 8-4.  Calibration

5. If you are using a physical device, right-click the NI-DAQmx device in the configuration tree 
and select Self-Calibrate to update the built-in calibration constants and calibrate the DAQ 
device using a precision voltage reference source. When the device has been calibrated, 
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information in the Self-Calibration section updates. Skip this step if you are using a 
simulated device.

Testing the DAQ Device Components
1. Click the Self-Test button in MAX to test the device. The device should pass the test 

because it is already configured.

2. Click the Test Panels button to test the individual functions of the DAQ device, such as 
analog input and output. The Test Panels dialog box appears.

 Use the Analog Input tab to test the various analog input channels on the DAQ device. 
Click the Analog Input tab. Click the Start button to acquire data from analog input 
channel 0 and click the Stop button when you finish. 

– If you are using the BNC-2120, make sure the switch over the AI 0 connector is 
in the Temp. Ref. position to connect the temperature sensor to ai0. Place your 
finger on the sensor to see the voltage rise. 

– If you are using a simulated device, a sine wave is shown on all input channels. 

 Use the Analog Output tab to set up a single voltage or sine wave on one of the DAQ 
device analog output channels. Click the Analog Output tab.

– Select Sinewave Generation in the Mode drop-down menu and click the Start 
button. MAX generates a continuous sine wave on analog output channel 0. 

– If you have hardware installed, you can read the sine wave that channel 0 outputs. 
On the BNC-2120, wire Analog Out Ch0 to Analog In Ch1. Click the Analog Input 
tab in the Test Panels dialog box and select Dev1/ai1 from the Channel Name 
drop-down menu. Click the Start button to acquire data from analog input channel 
1. MAX displays the sine wave from analog output channel 0.

 Use the Digital I/O tab to test the digital lines on the DAQ device. Click the Digital I/O 
tab.

– In the Select Direction section, set lines 0 through 3 as output as shown in 
Figure 8-5. 

Figure 8-5.  Digital I/O Line Direction

– Click Start to begin the digital output test, then toggle the switches in the Select 
State section shown in Figure 8-6. If you have a BNC-2120, toggling the switches 
turns the LEDs on or off. Notice that the LEDs use negative logic. 

Figure 8-6.  Digital I/O Switches

– Click Stop to stop the digital output test.

 Use the Counter I/O tab to determine if the DAQ device counter/timers are functioning 
properly. Click the Counter I/O tab.
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– If you have hardware installed, you can verify counter/timer operations by selecting 
Edge Counting from the Mode drop-down menu and clicking the Start button. The 
Counter Value indicator increments rapidly. Click Stop to stop the counter test.

 Click the Close button to close the Test Panel dialog box and return to MAX.

End of Exercise 8-1
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Three Ways to Connect with a DAQ Device

Connecting to a DAQ Device Using MAX
MAX lets you quickly test the connection to your DAQ device and configure the hardware, if 
necessary. With it you can also create simulated DAQ devices to create and test your 
application even if you don't have hardware available.

Access MAX by double-clicking the NI MAX desktop icon or selecting Tools»Measurement & 
Automation Explorer in LabVIEW. 

NI MAX DAQ Assistant DAQmx API

1: AT-MIO-64E-3
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Connecting Using LabVIEW DAQmx VIs
The LabVIEW DAQmx VIs let you control your hardware with finer options then the DAQ 
Assistant Express VI. The DAQmx VIs also let you make the measurement or generation you 
want to perform globally accessible from any application.

A basic DAQmx application involves the following process.

• Create task

• Configure task

• Start task

• Acquire or generate data

• Clear task

• Check for errors
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B. Automating Non-NI Instruments
Objective: Recognize the components of an instrument control system and practice 

connecting to hardware.

LabVIEW controls instruments through different buses.
LabVIEW can control stand-alone instruments, such as third-party oscilloscopes or analyzers, so 
you can automate instrument-based processes and consolidate multiple instrument tasks into 
one development environment.

Hardware connectivity The physical cable connecting the instrument. Also, the 
communication protocol, or bus. 

A basic instrument control system consists of an instrument, 
hardware connectivity, and a computer running LabVIEW. 
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Multimedia: Automating Non-NI Instruments
Common bus types include GPIB, serial, USB, and Ethernet. Different buses have different 
capabilities when it comes to latency and bandwidth. Instruments often have multiple ports for 
hardware connectivity.

Complete the multimedia module, Automating Non-NI Instruments, available in the 
<Exercises>\LabVIEW Core 1\Multimedia\ folder to learn about the relationship between 
LabVIEW and instrument control and how to use VISA to communicate with third-party 
instruments

Configuring Instrument Control in NI MAX 
Before creating your instrument control application, you should test communication with the 
instrument using NI MAX. 
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Exercise 8-3 Instrument Configuration with NI 
MAX

Goal
Learn to use MAX to examine and communicate with an instrument using GPIB interface 
settings. 

Set Up
This exercise uses the NI Instrument Simulator to simulate an instrument. Before MAX can 
recognize the NI Instrument Simulator as a device with a GPIB interface, you must configure the 
NI Instrument Simulator using the Instrument Simulator Wizard.

Complete the following steps to configure the NI Instrument Simulator to have a GPIB interface.

1. Configure the NI Instrument Simulator. 

 Power off the NI Instrument Simulator. 

 Set the configuration switch on the rear panel to CFG, as shown in Figure 8-10.

Figure 8-10.  NI Instrument Simulator

 Power on the NI Instrument Simulator using the power switch on the front of the unit.

 Verify that the PWR LED is lit and the RDY LED is flashing.

 Launch the NI Instrument Simulator Wizard from Start»All Programs»National 
Instruments»Instrument Simulator»Instrument Simulator Wizard.

Note This wizard is installed with the NI Instrument Simulator Software, available 
for download at ni.com.

 Click Next.

 Click Next.

 On the Select Interface page, select GPIB Interface and click Next.

 Select Change GPIB Settings and click Next.

 Select Single Instrument Mode and click Next.

 Set GPIB Primary Address to 1.

 Set GPIB Secondary Address to 0(disabled).

 Click Next.

 Click Update.

 Click OK when you get the message that the update was successful.
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 Power off the NI Instrument Simulator using the power switch on the front of the unit. 

 Set the configuration switch on the rear panel to NORM.

 Power on the NI Instrument Simulator using the power switch on the front of the unit.

 Verify that both the PWR and RDY LEDs are lit.

Implementation
1. Launch MAX by either double-clicking the icon on the desktop or by selecting Tools»

Measurement & Automation Explorer in LabVIEW.

2. View the settings for the GPIB interface.

 Expand the Devices and Interfaces section to display the installed interfaces. If a GPIB 
interface is listed, the NI-488.2 software is correctly loaded on the computer.

 Select the GPIB interface.

 Examine but do not change the settings for the GPIB interface.

3. Communicate with the GPIB instrument.

 Make sure the GPIB interface is still selected in the Devices and Interfaces section. 

 Click the Scan for Instruments button on the toolbar.

 Expand the GPIB interface selected in the Devices and Interfaces section. An 
instrument named Instrument Simulator appears.

 Click Instrument Simulator to display information about it in the right pane 
of MAX. Click the Attributes tab. Notice the NI Instrument Simulator has a GPIB 
primary address.

 Click the Communicate with Instrument button on the toolbar. An interactive window 
appears. You can use it to query, write to, and read from that instrument.

 Enter *IDN? in the Send String text box and click the Query button. The instrument 
returns its make and model number in the String Received indicator as shown in 
Figure 8-11. You can use this communicator window to debug instrument problems or 
to verify that specific commands work as described in the instrument documentation.

Figure 8-11.  Communication with the GPIB instrument

 Enter MEASURE:VOLTAGE:DC? in the Send String text box and click the Query button. 
The NI Instrument Simulator returns a simulated voltage measurement.
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 Click the Query button again to return a different value.

 Click the Exit button when done.

4. Set a VISA alias of devsim for the NI Instrument Simulator so you can use the alias instead 
of having to remember the primary address.

 While Instrument Simulator is selected in MAX, click the VISA Properties tab.

 Enter devsim in the VISA Alias on My System field. You  use this alias later in the 
course.

 Click Save.

5. Select File»Exit to exit MAX. 

6. Click Yes if prompted to save the instrument.

End of Exercise 8-3
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Simplify Instrument Control
Controlling your benchtop instrument using LabVIEW helps you save time by automating 
processes using the instrument such as testing and data logging. Instrument control in LabVIEW 
also lets you consolidate multiple instrument tasks into one development environment.

LabVIEW instrument drivers, available on the Instrument Driver Network at ni.com/idnet, 
provide the following additional benefits:

• Provide a high-level API, meaning that VIs perform multiple instructions, thereby simplifying 
the code.

• Do not require knowledge of different bus protocols, such as GPIB or serial, that you might 
use to connect with the instrument.

• Do not require learning low-level programming commands for each instrument.

Instrument Driver VIs for an Agilent Digital Multimeter
Every application that uses an instrument driver has a similar sequence of events: Initialize, 
Configure, Read Data, and Close.The block diagram initializes the Agilent 34401 digital 
multimeter (DMM), uses a configuration VI to choose the resolution and range, select the 
function, and enable or disable auto range, uses a data VI to read a single measurement, closes 
the instrument, and checks the error status. 
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The VIs in an instrument driver are organized into six categories. These categories are 
summarized in the following table.

Category Description

Initialize The Initialize VI establishes communication with the instrument and 
is the first instrument driver VI called.

Configure Configure VIs are software routines that configure the instrument to 
perform specific operations. After calling these VIs, the instrument 
is ready to take measurements or stimulate a system.

Action/Status Action/Status VIs command the instrument to carry out an action 
(for example, arming a trigger) or obtain the current status of the 
instrument or pending operations.

Data The data VIs transfer data to or from the instrument.

Utility Utility VIs perform a variety of auxiliary operations, such as reset and 
self-test.

Close The close VI terminates the software connection to the instrument. 
This is the last instrument driver VI called.
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Exercise 8-4 Exploring Instrument Drivers

Goal
Install an instrument driver and explore the example programs that accompany it. 

Implementation
Install the instrument driver for the NI Instrument Simulator. After installation, explore the VIs 
that the instrument driver provides and the example programs that are added to the NI Example 
Finder.

Figure 8-12.  NI Instrument Simulator

Install Instrument Driver and Open Project—Download from Internet
If you have internet access and have, or want to create, a user profile on ni.com, complete the 
following steps. Otherwise, install the driver from the course CD following the instructions in 
the Install Instrument Driver and Open Project—Extract from Disk section.

1. Select Help»Find Instrument Drivers.

2. Click the Login button.

3. If you have an ni.com profile, log in with your ID. 

4. If you do not have an ni.com profile, follow the onscreen instructions to create one at this 
time. Be sure to make a note of the user ID and password you create.

5. After you log in, click the Scan for Instruments button. If you have an instrument 
connected, clicking this button detects the instrument and finds the correct driver. In this 
case, it detects the Instrument Simulator. 

6. Double-click Instrument Simulator in the list and click the Search button.

7. Select Version 2.0 of the instrument driver from the Driver list.

8. Click the Install button.

9. Click the Start using this driver button.

10. Click the Open Project button. 

11. Expand the Examples folder in the Project Explorer window.

12. Close the NI Instrument Driver Finder window and go to the Explore Instrument Driver 
section to continue this exercise.
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Install Instrument Driver and Open Project—Extract from Disk
If you do not have Internet access or do not want to create a user profile, complete the following 
steps to install the instrument driver.

1. If you have it open, close LabVIEW and then navigate to the <Exercises>\LabVIEW Core 
1\Instrument Driver directory. This folder contains a zip file with the LabVIEW Plug and 
Play instrument drivers for the Instrument Simulator.

2. Right-click the zip file and follow the wizard to extract all files to the <Program 
Files>\National Instruments\LabVIEW 2014\instr.lib directory. 

3. Open National Instruments Instrument Simulator.lvproj in the <Program 
Files>\National Instruments\LabVIEW 2014\
instr.lib\National Instruments Instrument Simulator directory.

4. Expand the Examples folder in the Project Explorer window.

5. Go to the Explore Instrument Driver section to continue this exercise.

Explore Instrument Driver
1. Open National Instruments Instrument Simulator Acquire Single Measurement(DMM).vi 

from the Examples folder in the Project Explorer window of the National Instruments 
Instrument Simulator project. 

This VI reads a single measurement from the Instrument Simulator. 

2. Verify that the PWR and RDY LEDs are lit on the Instrument Simulator. 

3. Select devsim from the VISA Resource Name control on the front panel. You specified the 
VISA alias for this GPIB instrument as devsim in step 4 of Exercise 8-3, Instrument 
Configuration with NI MAX.

4. Run the VI.

5. Open the block diagram of the VI. 

6. Open the Functions palette and navigate to the Instrument I/O»Instrument Drivers»National 
Instruments Instrument Simulator palette.

7. Explore the palette and subpalettes using the Context Help window to familiarize yourself 
with the functionality of functions on the palette.

8. Stop and close the VI. Do not save changes.

9. Open National Instruments Instrument Simulator Acquire Waveform(Scope).vi from the 
project. This VI reads a single waveform from the Instrument Simulator. 

10. Select the same VISA resource name you selected in step 3. 

11. Run the VI. 

12. Select a different function from the Waveform Function control. 

13. Run the VI again. 

14. Explore the block diagram of the VI.

 To familiarize yourself with the VI’s functionality, explore the block diagram using the 
Context Help window.

 Double-click the Read Waveform VI to open it.
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 Open to the block diagram of the Read Waveform VI. Notice that it uses VISA functions 
to communicate with the instrument.

15. Close the VIs and project when you are finished. Do not save changes.

End of Exercise 8-4
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Additional Resources
Learn More About LabVIEW Help Topic or ni.com

Creating a DAQ system ni.com/DAQ

General-Purpose DAQ

Creating a Typical DAQ Application

Signal types and other 
measurement fundamentals

Taking Measurements

Displaying a Signal

Setting up and automating 
instrument control system

ni.com/instrument-control

ni.com/idnet

Using Instrument Drivers

Creating a Typical VISA Application

NI MAX Configuring DAQ Devices, Instruments, and Other 
Devices

LabVIEW Tools for DAQ Configuration (Windows)
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Activity 8-1: Lesson Review
1. What is NI MAX? (multiple answers)

a. A tool to configure and test DAQ devices

b. A tool to test instrument communication

c. A configurable Express VI

d. A window to view LabVIEW project files

2. Which of the following are benefits of instrument control? (multiple answers)

a. Automate processes

b. Improve productivity and repeatability

c. One platform for multiple tasks

d. Limited to only one type of instrument

3. VISA is a high-level API that calls low-level drivers.

a. True 

b. False
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Activity 8-1: Lesson Review - Answers
1. What is NI MAX? (multiple answers)

a. A tool to configure and test DAQ devices

b. A tool to test instrument communication

c. A configurable Express VI

d. A window to view LabVIEW project files

2. Which of the following are benefits of instrument control? (multiple answers)

a. Automate processes

b. Improve productivity and repeatability

c. One platform for multiple tasks

d. Limited to only one type of instrument

3. VISA is a high-level API that calls low-level drivers.

a. True 

b. False





9 Accessing Files 
in LabVIEW

In this lesson you will learn to describe the basic concept 
of file I/O and apply the appropriate File I/O functions to a 
given scenario.

Topics
+ Accessing Files from LabVIEW

+ High-Level and Low-Level File I/O Functions

+ Comparing File Formats

Exercises
Exercise 9-1 Exploring High-Level File I/O

Exercise 9-2 Temperature Monitor VI—Logging Data
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A.Accessing Files from LabVIEW
Objective: Identify the steps for writing and reading files from a LabVIEW application.

Typical File I/O Operations
File I/O operations pass data to and from files. 

File I/O Palette for File Operation Functions
The File I/O palette includes functions to create or open a file, read data from or write data to 
the file, and close the file. You can also use the functions to create directories; move, copy, or 
delete files; list directory contents; change file characteristics; or manipulate paths.

B. High-Level and Low-Level File I/O Functions
Objective: Identify when to use high-level and low-level File I/O functions.

1 Open File
2 Read/Write File

3 Close File
4 Check for Errors

High-Level File I/O Functions Low-Level File I/O Functions

Perform three steps of the file I/O process. 
(open/write/close)

Perform one step of the file I/O process.

Simplify block diagram. Provide finer control of file access.

Create unnecessary resource overhead when used 
in loops.

Save memory resources when used in 
loops. 

Are good to use when writing to a file in a single 
operation.

Are good to use when streaming data to 
disk.

1 2 3 4
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High-Level File I/O
High-level File I/O functions combine three steps (open, read/write, close) for common file I/O 
operations. High-level file I/O functions simplify the block diagram but might not provide the 
control or configuration you need for your application.

The following table compares the high-level file I/O functions. 

Function Type of Data File Formats

Write To Spreadsheet File

Read From Spreadsheet File

1D or 2D arrays Text

Write To Measurement File

Read From Measurement File

Signals (dynamic data 
types)

.lvm (text)

.tdms (binary)

Write Waveforms to File

Read Waveforms from File

Waveform data Text
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Exercise 9-1 Exploring High-Level File I/O

Goal
Observe how a high-level file I/O VI writes to a spreadsheet-readable file. 

Scenario
The Spreadsheet Example VI does the following:

• Generates sine, noise, and cosine data for 128 points 

• Stores this data in a 2D array that is 128 rows × 3 columns. 

• Displays the 2D array in a Table indicator with three columns (Sine, Noise, and Cosine) for 
the first 14 rows of the array. 

• Plots each column in a Waveform Graph indicator.

• Uses the Write To Spreadsheet File VI to save the numeric 2D array in a text file so a 
spreadsheet application can access the file.

Implementation
Complete the following steps to examine how the Spreadsheet Example VI performs the tasks 
described in the Scenario section.

1. Open Spreadsheet Example.lvproj in the 
<Exercises>\LabVIEW Core 1\Spreadsheet Example directory. 

2. Open Spreadsheet Example.vi from the Project Explorer window.

Figure 9-1.  Spreadsheet Example VI Front Panel

3. Run the VI.

4. Save the file, when prompted, as wave.txt in the 
<Exercises>\LabVIEW Core 1\Spreadsheet Example directory and click the OK 
button. You examine this file later.

5. Display and examine the block diagram for this VI.
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Figure 9-2.  Spreadsheet Example VI Block Diagram

• Sine Pattern VI—Returns a numeric array of 128 elements containing a sine pattern. 
The constant 90.0, in the second instance of the Sine Pattern VI, specifies the phase 
of the sine pattern which generates the cosine pattern.

• Uniform White Noise VI—Returns a numeric array of 128 elements containing a noise 
pattern.

• Build Array function—Builds the following 2D array from the sine array, noise array, and 
cosine array.

• Transpose 2D Array function—Rearranges the elements of the 2D array so element 
[i,j] becomes element [j,i], as follows.

• Write To Spreadsheet File VI—Formats the 2D array into a spreadsheet string and 
writes the string to a file. The string has the following format, where an arrow (→) 
indicates a tab, and a paragraph symbol (¶) indicates an end of line character.

• Number To Fractional String function—Converts an array of numeric values to an array 
of strings that the table displays.

6. Close the VI. Do not save changes.

Sine Array …

Noise Array …

Cosine Array …

S N C

… … …

S N C

® ® ¶

® ® ¶

® ® ¶

… … …

® ® ¶
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Note This example stores only three arrays in the file. To include more arrays, 
increase the number of inputs to the Build Array function.

7. Open the wave.txt file using a word processor, spreadsheet application, or text editor and 
view its contents.

 Open a word processor, spreadsheet application, or text editor, such as Notepad or 
WordPad.

 Open wave.txt. The sine waveform data appear in the first column, the random 
(noise) waveform data appear in the second column, and the cosine waveform data 
appear in the third column.

8. Exit the word processor or spreadsheet application and return to LabVIEW.

End of Exercise 9-1
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Low-Level File I/O 
Low-level File I/O functions provide individual functions for each step in file I/O operations. For 
example, one function opens an ASCII file, one function reads an ASCII file, and one function 
closes an ASCII file. 

File Refnums
File refnums identify unique file I/O sessions.

Streaming Data to Disk
Disk streaming is a technique for keeping files open while you perform multiple write operations. 
Use low-level functions when file I/O is occurring within a loop to save memory resources. 

1 Open, Initialize or create file resource—LabVIEW creates a reference number (refnum) as 
a unique identifier for the resource.

2 Read/Write to file
3 Close file resource—The refnum becomes obsolete
4 Check for errors—Display any errors from the file resource.

1 2 3 4
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String Functions
To write data to a text file, you must first convert the data into a string data type. Use the items 
from the String palette to convert numerics and other data types to text.

Tip Refer to the LabVIEW Help for details about formatting a string using the 
Format Into String function.
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C.Comparing File Formats
Objective: Recognize different options for logging data to disk.

Common Log File Formats
LabVIEW can use or create the following file formats: Binary, ASCII, LVM, and TDMS. 

• ASCII—An ASCII file is a specific type of binary file that is a standard used by most 
programs. It consists of a series of ASCII codes. ASCII files are also called text files.

• LVM—The LabVIEW measurement data file (.lvm) is a tab-delimited text file you can open 
with a spreadsheet application or a text-editing application. The .lvm file includes 
information about the data, such as the date and time the data was generated. This file 
format is a specific type of ASCII file created for LabVIEW.

• Binary—Binary files are the underlying file format of all other file formats. 

• TDMS—This file format is a specific type of binary file created for National Instruments 
products. It actually consists of two separate files—a binary file that contains data and 
stores properties about the data, and a binary index file that provides consolidated 
information on all the attributes and pointers in the binary file.

Comparing File Formats
Use text files when you want to access the file from another application, if disk space and file 
I/O speed are not crucial, if you do not need to perform random access read or writes, and if 
numeric precision is not important.

Additional Resources

ASCII Binary TDMS LVM

Easily Exchangeable X X X

Small disk footprint X X

Random read/write access X X X

Inherent attributes X X

High-speed streaming X

Learn More About LabVIEW Help Topic

File I/O File I/O

Streaming data to disk Saving Memory using Disk Streaming

Streaming External Data to a TDMS File (Windows)

File Formats for file I/O Determining Which File Format to Use

Converting Numbers into Strings
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Activity 9-1: Lesson Review
1. After opening a file, which output does the Open/Create/Replace File I/O function return?

a. File path

b. File name

c. Refnum out

d. Task out

2. Which file format is best in an application that requires high-speed streaming?

a. ASCII

b. Binary

c. TDMS

d. LVM
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Activity 9-1: Lesson Review - Answers
1. After opening a file, which output does the Open/Create/Replace File I/O function return?

a. File path

b. File name

c. Refnum out

d. Task out

2. Which file format is best in an application that requires high-speed streaming?

a. ASCII

b. Binary

c. TDMS

d. LVM





10 Using 
Sequential and 
State Machine 
Programming

In this lesson you will learn how to identify sequential and 
state programming and explore the State Machine design 
pattern. 

Topics
+ Using Sequential Programming

+ Using State Programming

+ State Machines

Exercises
Exercise 10-1 Weather Station Project
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A.Using Sequential Programming
Objective: Use dataflow to ensure sequential execution of nodes.

Why Use Sequential Programming? 
Sequential programming ensures the execution order of tasks. In the following block diagram 
there is no mechanism to force the execution order of these events. Any one of these events 
could happen first.

Flow-Through Parameters
To enforce sequential programming in LabVIEW, you can complete sequential tasks by placing 
each task in a separate subVI, and wiring the subVIs in the order you want them to execute 
using the error cluster wires. 

However, in this example, only two of the tasks have a error cluster. Using the error clusters, 
you can force the execution order of the two DAQ Assistants, but not the One Button Dialog 
functions, as shown in the following figure.
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Sequence Structures
A Sequence structure contains one or more subdiagrams, or frames, that execute in sequential 
order; a frame cannot begin execution until everything in the previous frame has completed 
execution. 

Avoid Overuse of Sequence Structures
To take advantage of the inherent parallelism in LabVIEW, avoid overusing Sequence structures. 
Below are some caveats while using Sequence structures:

• Sequence structures guarantee the order of execution, but prohibit parallel operations.

• You cannot stop the execution part way through the sequence. 

• Use Sequence structures sparingly because they do not enforce error checking and will 
continue to go through a sequence even after errors are detected.

Error Case Structure
Error Case structures rely on data flow rather than sequence structures to control the order of 
execution.
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B. Using State Programming
Objective: Describe the functionality represented by a state transition diagram.

Why Use State Programming? 
• Change the order of a sequence

• Repeat an item in sequence more often than others

• Execute only if certain conditions are met

• Stop the program immediately

State Transition Diagram
A state transition diagram is a type of flowchart that indicates the states of a program and 
transitions between states

State Part of a program that satisfies a condition, performs an action or waits for an 
event.

Transition Condition, action, or event that causes the program to move to the next state.

Initialize

Acquistion

Data log

Analysis

Time
Check

Time Elapsed = FALSE
and

Stop = FALSE

Stop = TRUE

Warning = TRUE

Time Elapsed = TRUE
and

Stop = FALSE

Warning = FALSE
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C. State Machines
Objective: Determine when to use a state machine.

What is a State Machine? 
A state machine is a common and useful design pattern in LabVIEW that usually has a start-up 
and shut-down state, but also contains other states. State machines can implement any 
algorithm that can be explicitly described by a state diagram or flowchart.
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When to Use a State Machine
Use a state machine for the following applications:

• Sequential process

• UI-Driven process

Sequential Process

• A state represents each segment of the process. 

• Depending on the result of each state’s test, a different state might be called. 

• Can happen continually, resulting in an in-depth analysis of the process you are testing

UI-Driven Process

• Different user actions process different code and act as a state in the state machine. 

• Each segment can lead to another segment for further processing or wait for another user 
action. 

• The state machine constantly monitors the user for the next action to take.

• Applications require an initialization state, followed by a default state, where many different 
actions can be performed. The actions performed can depend on previous and current 
inputs and states. A shutdown state commonly performs clean up actions. 
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Multimedia: Building State Machines
Complete the multimedia module, Building State Machines, available in the 
<Exercises>\LabVIEW Core 1\Multimedia\ folder to learn about the following topics.

• State Machine Infrastructure

• State Machine Transitions

– Single Default 

– Select Function

– Case Structure

– Transition Array

Course Project Transition Diagram
Consider the following example. An application acquires a temperature every half second, 
analyzes each temperature to determine if the temperature is too high or too low, and alerts the 
user if there is a danger of heatstroke or freeze. The application logs the data if a warning 
occurs. If the user has not clicked the stop button, the entire process repeats. The following 
figure shows the state transition diagram for this temperature warning application.

Initialize

Acquistion

Data log

Analysis

Time
Check

Time Elapsed = FALSE
and

Stop = FALSE

Stop = TRUE

Warning = TRUE

Time Elapsed = TRUE
and

Stop = FALSE

Warning = FALSE
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Event-Based State Machine
Event-based state machines combine a user interface event handler with the transition ability of 
the state machine. Event-based state machines include a “Wait on Event” case to process 
user-interface events.

Demonstration: Simple State Machine Project Template
LabVIEW provides the Simple State Machine project template to simplify the process of creating 
an application that uses the event-based state machine design pattern.

• The Simple State Machine template is a customizable application which is in the form of 
a .lvproj file with supporting VIs and type definition controls. 

• The application is based on the event-based state machine design pattern.

Initialize

Wait for
Event

Stop

User
State 2

User
State 1
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Additional Resources

Learn More About LabVIEW Help Topic or ni.com

Sequential Design Sequence Structures: Executing Sections of Code 
Sequentially

State Machines Creating VIs from Templates and Sample Projects

Examples, VI Templates, Project Templates, and 
Sample Projects

Events Events in LabVIEW

Event Structure

Caveats and Recommendations when Using Events in 
LabVIEW
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Activity 10-1: Lesson Review
1. When using a Sequence structure, you can stop the execution in the middle of a sequence.

a. True

b. False

2. Which of the following are benefits of using a state machine instead of a sequential 
structure?

a. You can change the order of the sequence. 

b. You can repeat individual items in the sequence.

c. You can set conditions to determine when an item in the sequence should execute.

d. You can stop the program at any point in the sequence.
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Activity 10-1: Lesson Review - Answers
1. When using a Sequence structure, you can stop the execution in the middle of a sequence.

a. True

b. False

You cannot stop the execution in the middle of a sequence.

2. Which of the following are benefits of using a state machine instead of a sequential 
structure?

a. You can change the order of the sequence. 

b. You can repeat individual items in the sequence.

c. You can set conditions to determine when an item in the sequence should execute.

d. You can stop the program at any point in the sequence.





A Additional 
Information and 
Resources

National Instruments provides global services and support 
as part of our commitment to your success. Take 
advantage of product services in addition to training and 
certification programs that meet your needs during each 
phase of the application life cycle; from planning and 
development through deployment and ongoing 
maintenance.





LabVIEW Core 1 Participant Guide

© National Instruments | A-3

A.NI Services
To get started, register your product at ni.com/myproducts.

As a registered NI product user, you are entitled to the following benefits:

• Access to applicable product services.

• Easier product management with an online account.

• Receive critical part notifications, software updates, and service expirations.

Log in to your National Instruments ni.com User Profile to get personalized access to your 
services.

B. Services and Resources
• Maintenance and Hardware Services—NI helps you identify your systems’ accuracy and 

reliability requirements and provides warranty, sparing, and calibration services to help you 
maintain accuracy and minimize downtime over the life of your system. Visit ni.com/
services for more information.

– Warranty and Repair—All NI hardware features a one-year standard warranty that is 
extendable up to five years. NI offers repair services performed in a timely manner by 
highly trained factory technicians using only original parts at a National Instruments 
service center.

– Calibration—Through regular calibration, you can quantify and improve the 
measurement performance of an instrument. NI provides state-of-the-art calibration 
services. If your product supports calibration, you can obtain the calibration certificate 
for your product at ni.com/calibration.

• System Integration—If you have time constraints, limited in-house technical resources, or 
other project challenges, National Instruments Alliance Partner members can help. To learn 
more, call your local NI office or visit ni.com/alliance.

• Training and Certification—The NI training and certification program is the most effective 
way to increase application development proficiency and productivity. Visit 
ni.com/training for more information.

– The Skills Guide assists you in identifying the proficiency requirements of your current 
application and gives you options for obtaining those skills consistent with your time 
and budget constraints and personal learning preferences. Visit ni.com/
skills-guide to see these custom paths.

– NI offers courses in several languages and formats including instructor-led classes at 
facilities worldwide, courses onsite at your facility, and online courses to serve your 
individual needs.

• Technical Support—Support at ni.com/support includes the following resources:

– Self-Help Technical Resources—Visit ni.com/support for software drivers and 
updates, product manuals, step-by-step troubleshooting wizards, thousands of 
example programs, tutorials, application notes, and instrument drivers. Registered 
users also receive access to the NI Discussion Forums at ni.com/forums. NI 
Applications Engineers make sure every question submitted online receives an answer.

– Software Support Service Membership—The Standard Service Program (SSP) is a 
renewable one-year subscription included with almost every NI software product, 
including NI Developer Suite. This program entitles members to direct access to 
NI Applications Engineers through phone and email for one-to-one technical support, as 
well as exclusive access to online training modules at ni.com/
self-paced-training. NI also offers flexible extended contract options that 
guarantee your SSP benefits are available without interruption for as long as you need 
them. Visit ni.com/ssp for more information.
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• Declaration of Conformity (DoC)—A DoC is our claim of compliance with the Council of the 
European Communities using the manufacturer’s declaration of conformity. This system 
affords the user protection for electromagnetic compatibility (EMC) and product safety. You 
can obtain the DoC for your product by visiting ni.com/certification.

For information about other technical support options in your area, visit ni.com/services, or 
contact your local office at ni.com/contact.

You also can visit the Worldwide Offices section of ni.com/niglobal to access the branch 
office websites, which provide up-to-date contact information, support phone numbers, email 
addresses, and current events.

C.Other National Instruments Training Courses
National Instruments offers several training courses for LabVIEW users. These courses continue 
the training you received here and expand it to other areas. Visit ni.com/training to purchase 
course materials or sign up for instructor-led, hands-on courses at locations around the world.

D.National Instruments Certification
Earning an NI certification acknowledges your expertise in working with NI products and 
technologies. The measurement and automation industry, your employer, clients, and peers 
recognize your NI certification credential as a symbol of the skills and knowledge you have 
gained through experience. Visit ni.com/training for more information about the 
NI certification program.


